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Legal Notices 
Hewlett-Packard makes no warranty of any kind with regard to this manual, including, but not limited to, 
the implied warranties of merchantability and fitness for a particular purpose. Hewlett-Packard shall not 
be held liable for errors contained herein or direct, indirect, special, incidental or consequential damages 
in connection with the furnishing, performance, or use of this material.

Warranty.  A copy of the specific warranty terms applicable to your Hewlett- Packard product and 
replacement parts can be obtained from your local Sales and Service Office.

Restricted Rights Legend. All rights are reserved. No part of this document may be photocopied, 
reproduced, or translated to another language without the prior written consent of Hewlett-Packard 
Company. The information contained in this document is subject to change without notice.

Use, duplication or disclosure by the U.S. Government is subject to restrictions as set forth in 
subparagraph (c) (1) (ii) of the Rights in Technical Data and Computer Software clause at DFARS 
252.227-7013 for DOD agencies, and subparagraphs (c) (1) and (c) (2) of the Commercial Computer 
Software Restricted Rights clause at FAR 52.227-19 for other agencies.

Use of this manual and flexible disk(s), tape cartridge(s), or CD-ROM(s) supplied for this pack is 
restricted to this product only. Additional copies of the programs may be made for security and back-up 
purposes only. Resale of the programs in their present form or with alterations, is expressly prohibited.

Copyright Notices. ©copyright 1983-98 Hewlett-Packard Company, all rights reserved.

Reproduction, adaptation, or translation of this document without prior written permission is prohibited, 
except as allowed under the copyright laws.
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Printing History 
New editions of this manual incorporate all material updated since the previous edition. The manual 
printing date and part number indicate its current edition. The printing date changes when a new edition 
is printed. (Minor corrections and updates which are incorporated at reprint do not cause the date to 
change.) The manual part number changes when extensive technical changes are incorporated.

January 1995.......................................................................................................................  Edition 1

September 1995..................................................................................................................  Edition 2

June 1996 ............................................................................................................................ Edition 3

July 1997 .................................................................................................Edition 4 (Not distributed)

July 1997 ............................................................................................................................  Edition 5

January 1998 ....................................................................................................................... Edition 6

June 1998 ............................................................................................................................ Edition 7

Change Narrative

• Edition 7 technical changes include: 

a. The addition of HP9000/K360 information where applicable in Chapter 2.

b. Minor changes and updates as required. 

• Edition 6 technical changes include:

a. The addition of HP9000/K380/K580 information where applicable. 

b. Minor changes and updates throughout the manual. 
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NOTE Reader Comments. We welcome your comments about our documentation. If you have 
editorial suggestions or recommend improvements for this document, please write to us. 
You can reach us through e-mail at: hardwaredocs@cup.hp.com or by sending your letter 
to: Documentation Manager, M/S 5657, Hewlett-Packard Company, 8000 Foothills Blvd., 
Roseville, CA 95747-5657 USA. Please include the following information in your 
message:

• Title of the manual you are referencing.

• Manual part number (from the title page).

• Edition number or publication date (from the title page).

• Your name.

• Your company’s name.

SERIOUS ERRORS, such as technical inaccuracies that may render a program or a 
hardware device inoperative, should be reported to your HP Response Center or directly 
to a Support Engineer.
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FCC Statement (USA Only) 
• The United States Federal Communications Commission has specified that the following notice be 

brought to the attention of users of this product:

• FCC rules part 15, subpart A, Class A devices.

• Information to User (section 15.105)

WARNING This equipment has been tested and found to comply with the limits for a Class A 
digital device, pursuant to part 15 of the FCC rules. These limits are designed to 
provide reasonable protection against harmful interference when the equipment is 
operated in a commercial environment. This equipment generates, uses, and can 
radiate radio frequency energy and, if not installed and used in accordance with the 
instruction manual, may cause harmful interference to radio communications. 
Operation of this equipment in a residential area is likely to cause harmful 
interference in which case the user will be required to correct the interference at his 
own expense. 

Hewlett-Packard's system certification tests were conducted with HP-supported peripheral devices and 
HP shielded cables, such as those you receive with your computer. Changes or modifications not 
expressly approved by Hewlett-Packard could void the user's authority to operate the equipment. Cables 
used with this device must be properly shielded to comply with the requirements of the FCC.

FCC Telecommunications Regulatory Information 

• This equipment complies with Part 68 of the FCC rules. On the outside surface of this equipment is a 
label that contains among other information, the FCC registration, the FCC registration number and 
ringer equivalence number (REN). If requested, this information must be provided to the telephone 
company.

• This equipment uses the following Universal Service Code (USOC) jacks: RJ11C or RJ11W (single 
line).

• The REN equivalence number (REN) is used to determine the quantity of devices which may be 
connected to the telephone line. Excessive RENs on the telephone line may result in the devices not 
ringing in response to an incoming call. In most, but not all areas, the sum of the RENs should not 
exceed five (5.0). To be certain of the number of devices that may be connected to the line, as 
determined by the total RENs, contact the telephone company to determine the maximum REN for 
the calling area.

• If this equipment causes harm to the telephone network, the telephone company will, where 
practicable, notify you in advance that temporary discontinuance of service may be required. If 
advance notice isn’t practical, the telephone company will notify the customer as soon as possible. 
Also, you will be advised of your right to file a complaint with the FCC if you believe it is necessary.

• The telephone company may make changes in its facilities, equipment, operations, or procedures that 
could affect the operation of the equipment. If this happens, the telephone company will provide 
advance notice in order for you to make the necessary modifications in order to maintain 
uninterrupted service.
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• If trouble is experienced with this equipment, please contact Hewlett-Packard in the USA for repair 
and/or warranty information. If the trouble is causing harm to the telephone network, the telephone 
company may request you remove the equipment from the network until the problem is resolved.

• No repairs are to be made by you. Repairs are to be made only by Hewlett-Packard or its licensees. 
Unauthorized repairs void registration and warranty.

• This equipment cannot be used on telephone company-provided coin service. Connection to Party 
Line Service is subject to state tariffs. (Contact the state public utility commission, public service 
commission, or corporation commission for information.)

• If so required, this equipment is hearing-aid compatible.

Notice for Canada: DOC Requirements 
This Class A digital apparatus meets all requirements of the Canadian Interference-Causing Equipment 
regulations.

Cet appareil numérique de la classe A respecte toutes les exigences du Reglement sur le matériel 
brouilleur du Canada.

DOC Terminal Equipment Warnings 

NOTE The Canadian Department of Communications label identifies certified equipment. This 
certification means that the equipment meets certain telecommunication network 
protective operational and safety requirements. The Department does not guarantee the 
equipment will operate to the user's satisfactions.

Before installing this equipment, users should ensure that it is permissible to be connected to the 
facilities of the local telecommunications company. The equipment must also be installed using an 
acceptable method of connection. In some cases, the company's inside wiring associated with a single 
line individual service may be extended by means of a certified connector assembly (telephone extension 
cord). The customer should be aware that compliance with the above conditions may not prevent 
degradation of service in some situations.

Repairs to certified equipment should be make by an authorized Canadian maintenance facility 
designated by supplier. Any repair or alteration made by the user to this equipment or equipment 
malfunctions, may give the telecommunications company cause to request the user to disconnect the 
equipment.

Users should ensure for their own protection that the electrical ground connection of the power utility, 
telephone lines and internal metallic water pipe system, if present, are connected together. This 
precaution may be particularly important in rural areas.

The Load Number (LN) assigned to each terminal devise denotes the percentage of total load to be 
connected to a telephone loop which is used by the device to prevent overloading. The termination on a 
loop may consist of any combination of devices subject only to the requirement that the total of the LD 
of all the devices does not exceed 100. The load number for this product is 33.

CAUTION Users should not attempt to make such connections themselves, but should contact the 
appropriate electric inspection authority, or electrician, as appropriate.
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Notice for Sweden: National Post and 
Telecommunications Agency Statement 

The LAN Interface shall be connected to SELV (max. 42,4 V peak, or 60 VDC etc.) according to EN 60 
950.

Notice for Australia: AUSTEL Statement 
(Telecommunications)

When setting the number of automatic redial for the modem, ensure the following:

The number of automatic redials that the modem performs should be limited to a maximum of 9 redials 
plus the original call. If the above retries are unsuccessful, no further attempts should be made the same 
number for a minimum period of 5 minutes.

Failure to set the modem, and any communications software used with the modem to the values 
contained in the listing will result in the modem being operated in a non-compliant manner. 
Consequently, there would be no permit in force for this equipment and the Telecommunications Act 
1991 prescribes a penalty of $12,000 for the connection of non-permitted equipment.

Notice for New Zealand: New Zealand Teleco Statement 
When using an application software that allows the setting of automatic redialing the following 
guidelines should be followed:

• Not more than five call attempts to the same number within a one hour period.

• A minimum of 60 seconds between each attempt.

• Not more than a total of 10 call attempts to the same number.

• Any setting that violates the above guidelines will cause the equipment to go out of compliance, and 
thus no Telepermit will be enforced for this equipment which will make it subject to penalties.

• The operation of this equipment on the same line as telephones or other equipment with audible 
warning devices or automatic ring detectors will give rise to bell tinkle or noise and may cause false 
tripping of the ring detector. Should such problems occur, the user is not to contact Telecom Faults 
Service.
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Australian EMI Approval.

UK General Approval (United Kingdom only) 
Pursuant to section 22 of Telecommunications Act of 1984, this product is approved for indirect 
connection to Public Telecommunications systems within the United Kingdom under the general 
Approval number NS/G/1234/J/100003.

EMI Statement (European community only) 
This is a Class A product. In a domestic environment, this product may cause radio interference in which 
case the user may be required to take adequate measures.

Acoustics (Germany) 

Lärmangabe (Schalldruckpegel LpA) gemessen an Arbeitsplatz bei normalem Betrieb nach DIN 45635, 
Teil 19: 

Acoustic Noise (A-weighted sound Pressure Level LpA) measured at operator's position, normal 
operation, to ISO7779.

HP9000 Kxxx: LPA < 64 dB, no prominent tones at 22×C
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European Declaration of Conformity
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Radio Frequency Interference Statement (Japan 
only) 

Power Line Harmonics Conformance (Japan only)



 xi

Safety 
This product has not been evaluated for connection to an "IT" power system (AC distribution system 
having no direct connection to earth according to IEC 950).

Locate the AC outlet near the computer. The AC power cord is this product's main AC disconnect device 
and must be easily accessible at all times.

To reduce the possibility of an electric shock from the telephone network, plug the computer into the AC 
outlet prior to connecting to the network. Also, disconnect the network before unplugging the computer 
from the AC power outlet.

This product is designed to operate at the AC line voltages of 100, 120-127, or 200-240 V±10%. Contact 
your HP Sales Office if your line voltage is outside this range.

Battery Notices 
This product may contain a Lithium battery. Replace only with the same type and part number. Recycle 
used batteries.

WARNING Fire, explosion and severe burn hazard! Do not crush, disassemble, heat, incinerate 
or expose the battery to water.

CD-ROM Drives 
The following warnings apply to those products that support CD-ROM drives. Please also refer to the 
documentation provided with the CD-ROM drive.

Laser Safety Statement (US only) 

The CD-ROM mass storage system contains a laser system classified as a "Class 1 Laser Product" under 
a U.S. Department of Health and Human Services (DHHS) Radiation Performance standard according to 
the Radiation Control for Health and Safety Act of 1968.

To ensure proper use of this product, please read the CD-ROM instruction manual carefully and retain 
for future reference. Should the unit ever require maintenance, contact an authorized service location.

WARNING Use of controls, adjustments or performance procedures other than those specified 
herein may result in hazardous radiation exposure. To prevent direct exposure to 
laser beam, do not try to open the enclosure.

Finland (only) 
LASERTURVALLISUUS 

LUOKAN 1 LASERLAITE 
KLASS 1 LASER APPARAT

 HP 9000 Series Kxxx -tietokoneisiin on asennettu laitteensisäinen CD-ROM-lukulaite (9164-0393), 
joka on laserlaite. 
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Kyseinen CD-ROM-lukulaite on käyttäjän kannalta turvallinen luokan 1 laserlaite. Normaalissa käytössä 
lukulaitteen suojakotelo estää lasersäteen pääsyn laitteen ulkopuolelle. Laitteen turvallisuusluokka on 
määritetty standardin EN 60825-1 (1994) mukaisesti.

 Tiedot CD-ROM-lukulaitteessa käytettävän laserdiodin säteilyominaisuuksista:

Germany 
Dieses Gerät ist ein Laser Klasse 1 nach IEC 825. Beachten Sie die Bedienungsanleitung und verwahren 
Sie diese für späteren Gebrauch.

Gerät nicht öffnen. Lassen Sie Instandhaltungsarbeiten durch vertragswerkstätten durchführen.

WARNING VORSICHT 

Führen sie Einstellungen and Prüfungen entsprechend den hier beschriebenen 
Anleitungen durch, um Gef öchtdungen durch den Laserstrahl zu vermeiden.

Aallonpituus 790 nm 

Teho 0,3 mW
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1 System Overview

Using this Manual 

Hardware Installation 

This manual is intended to help you complete the installation of your HP9000 Model Kxx0 computer. 
The explanations in this manual assume you have followed the instructions in the HP9000 Installation 
Guide that was shipped with your computer. The installation guide explains how to physically connect 
all the different components of your system. If you have not completed the instructions in the Installation 
Guide, please do that before you continue with the instruction in this Owner's Guide. If you do not have 
the Installation Guide you can use Appendix B — Hardware Installation Review of this manual to 
complete the hardware installation.

Site Preparation 
It is important that you verify that you have the proper electrical and environmental conditions in which 
to operate this computer. Review Appendix A — Site Preparation in this manual before you actually 
apply electrical power to your computer. Your computer and peripherals could be damaged if they are not 
operated within the environmental and electrical tolerances listed in Appendix A.

Computer Orientation 
Review Chapter 2 - Exploring Your Hardware to familiarize yourself with the components of your 
computer. Since this manual tends to leverage information available in other books, you should also have 
at hand, for reference, the other manuals that came with your computer, such as:

• Installing HP-UX 10.x

• HP9000/Kx00 Internal Peripherals Upgrade Guide

• Using HP-UX

Turning on Your Computer 
When you have connected the hardware, verified that the physical and electrical environments are 
appropriate for your computer, and familiarized yourself with the components of your computer, follow 
the steps in Chapter 3 — Turning On Your Computer to launch your operating system. Use some of the 
hints in Chapter 4 — Troubleshooting if the launching does not proceed as expected. If the computer still 
does not seem to run properly, contact your HP representative.
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Administering Your Computer 

Proceed with Chapters 5 through 8 to configure and backup your system.

Other Information

Other Information in this Manual 
The Table of Contents should help you locate information on specific topics. A Glossary is provided to 
help familiarize you with terms used in this manual

There is an appendix that contains internal address path information. You may need to refer to this 
appendix when you need to configure or reconfigure your system.

Other Information not in this Manual 
There are other Hewlett-Packard manuals that may be useful. Although the names of these manuals may 
change from one HP-UX release to another, the titles will relate to the following topics:

• Configuring HP-UX for, or Installing, Peripherals

• HP-UX System Administration Tasks

• HP-UX Reference

The HP-UX manuals online-manual page lists the HP-UX manuals available from Hewlett-Packard. At 
the prompt, type

man manuals

You can order these manuals from HP Direct, toll-free, at 1-800-637-7748 in the United States, or you 
can contact your nearest HP Sales and Support office

You will also need one set of operating system tapes, per site, in case your pre-loaded operating system 
becomes corrupted and you are unable to boot up (start) your operating system. You can order the 
operating system tapes from Hewlett-Packard.
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Available HP Support Classes 
Hewlett-Packard provides optional support directly to you using a support modem which connects your 
computer to HP through the telephone line. Two available support programs are: HP ResponseLine and 
HP TeamLine.

Hewlett-Packard's support programs provide HP customer's with help in implementing and operating HP 
software solutions. They deliver different levels of assistance and problem-solving, and can be 
customized for your needs. For more information on the support services that are available to you, 
contact your local HP Sales and Service Office.

Hewlett-Packard's Customer Education services provide high-quality training solutions worldwide to 
help you maximize the value of your investment. HP training courses enable you to enhance your 
problem-solving abilities, use your hardware and software capabilities fully, and eliminate trial-and-error 
learning. HP provides specific courses on many aspects of both HP-UX and HP-UX Systems 
Administration. As a requirement of the software support agreement, which allows access to the 
Response Center for telephone assistance, authorized callers must attend appropriate training.

For a catalog of courses or for detailed information on Hewlett-Packard's Customer Education services, 
in the U.S. please call (800) HP-CLASS, in Canada please call (416) 678-9430, and elsewhere, please 
call your local Hewlett-Packard Customer Education Center.
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2 Exploring Your Hardware

Hewlett Packard 9000 Computer Systems
This section provides general specifications and information describing the HP 9000 computer systems.

Table 2-1 HP 9000 General Specifications

NOTE Detailed Environmental and Electrical specifications are available in Appendix A — Site 
Preparation.

Physical Specifications
Table 2-2  Model K Physical Specifications

Core System Hardware
The HP 9000/K100, K2x0, K3x0, K4x0, and K5x0 are a new family of PA-RISC computer systems from 
Hewlett Packard. There are two basic classes of systems, multiprocessors (more than one processor) and 
uniprocessor (single processor system).

Specifications Physical Specification

Core System Hardware The components that comprise the core system, 
System Processor Unit (SPU), Uninterruptible 
Power System (UPS) and system console

Removable Media Peripherals Controls and indicators for standard internal 
peripherals

Physical 
Characteristic

Stand-alone 
Specifications

Packaged 
Specifications

Height 63.50cm (25in) 87.00cm (34.25in)

Width 43.18cm (17in) 88.90cm (35in)

Depth 69.85cm (27.5in) 77.47cm (30.5in)

Weight 59kg (131lb)a

a. Kx50/Kx60/Kx70/Kx80 models slightly 
heavier

76.66kg (169lbs)a
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Multiprocessor Systems

6 - Way Processor Systems. The HP9000 K370/K380 and K570/K580 models are available with 1 - to 
6 - way processors.

K370 Product A3663A, single processor system with 128 MBytes ECC memory, 200MHz 
clock speed.

Up to five additional processors (Product A3669A).

K380 Product A4869A, single processor system with 128 MBytes ECC memory, 240 MHz 
clock speed.

Up to five additional processor (Product A4872A).

K570 Product A3641A, single processor system with 256 MBytes ECC memory, 200MHz 
clock speed.

Up to five additional processors (Product A3669A).

K580 Product A4837A, single processor system with 128 MBytes ECC memory, 240 MHz 
clock speed.

Up to 5 additional processors (Product A4872A).

4 - Way Processor Systems. The HP9000/K2x0 and K4x0 models are multiprocessor systems. They 
are available with 1 to 4 way processors.

K460 Product A3284A, single processor system with 128M Bytes ECC memory, 180 MHz 
clock speed. 

Up to three additional processors (Product A3261A), no additional memory.

K450 A3464A single processor - 128M Bytes ECC memory, 160 MHz clock speed

 Up to three additional processors (Product A3498A), no additional memory

K420 A3454A single processor - 128M Bytes memory, 120 MHz clock speed 

Up to three additional processors (Product A3452A), no additional memory

K410 A3283A single processor - 128M Bytes memory, 120 MHz clock speed 

Up to three additional processors (Product A2995A), no additional memory

K400 A3181A single processor - 128M Bytes memory,  100 MHz clock speed

Up to three additional processors (Product A2993A), no additional memory

K360 A5140A one to four 180 MHz PA-8000 RISC processors - 128 M Bytes memory.

K260 A3205A single processor - 128M Bytes memory, 180 MHz clock speed

Up to three additional processors (Product A3261A), no additional memory

K250 A3463A single processor - 128M Bytes memory,  180 MHz clock speed 

Up to three additional processors (Product A3498A), no additional memory,  160 
MHz clock speed
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K220 A3453A single processor - 128M Bytes memory,  120 MHz clock speed 

Up to three additional processors (Product A3452A), no additional memory

K210 A3281A single processor - 64M Bytes memory,  100 MHz clock speed
A3282A single processor - 128M Bytes memory,  100 MHz clock speed 

Up to three additional processors (Product A2995A), no additional memory

K200 (A3060A) single processor - 64M Bytes memory, 100 MHz clock speed, OR 
(A3061A) single processor - 128M Bytes memory,  100 MHz clock speed 

Up to three addition processors (Product A2993A), no additional memory

Uniprocessor

The HP 9000/K100 operates at 100 MHz clock speed. It has one processor. The rear of the K100 SPU 
has no processor slots.

K100 A3038A single processor - 32M Bytes memory 

A3039A single processor - 128M Bytes memory

Figure 2-1 Model K100 SPU

All models of the Model K are identical from the front, with the exception of the name plate.
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HP 9000 Series 800 Model K Hardware Overview
A core system includes the System Processing Unit (SPU), system console and optional external 
Uninterruptible Power System (UPS). A system can be operated without a UPS or local system console.

Figure 2-2 SPU with Front Door Open

Rack Mounting
A rack mount version of all models is available. Most rack mount systems are assembled at the factory 
but a field upgrade rack kit is available.

System Identification Information
Your SPU Serial Number and other information for the unit are located on the inside of the front door.
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System Processing Unit Controls

The System Processing Unit (SPU) has one front panel control, a Key Switch and the Liquid Crystal 
Display (LCD) on the right side.

Table 2-3  Key Switch Functions

Figure 2-3 Key Switch

WARNING With the key switch in the STANDBY position, hazardous voltages exist inside the 
computer. To remove AC power from the computer, unplug the power cord from the 
back of the SPU.

Function Description

Standby A warm up mode where DC power is applied to the LCD display 
and internal components. The processor does not function. 

ON The standard mode for full operation

Service The mode for checking the status of system components and 
functions and for running system diagnostics.

Fully counter-clockwise - “Standby”

Middle position - “on”

Fully clockwise - “Service”
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Liquid Crystal Display Panel

The LCD Panel (See Figure 2-4) shows system status information and power-on indication. The various 
LCD Panel messages and their meanings are explained in the start-up procedure. A typical message that 
would appear in the panel when your Model K is booted and running is shown in Figure 2-5.

Figure 2-4 LCD Panel

Figure 2-5 LCD Panel Message

1. LCD Panel Location

RUNFXYF

CPU 01
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System Console Controls

The System Console can be a graphics or text monitor, depending on your system. The console controls 
will conform to something similar to the controls in Figure 2-6 for the HP700/96 and similar terminals, 
or like the controls in Figure 2-7 for some of the graphics monitors.

Figure 2-6 Typical Text Console Controls

Figure 2-7 Typical Graphic Console Control

1. ON/OFF Switch

2. Brightness Control

3. Contrast Control

1. ON/OFF Switch

2. Brightness Control

3. Contrast Control
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Uninterruptible Power System (UPS)

A UPS is optional on HP 9000 Systems. In a power outage, it provides AC power to the SPU and console 
for approximately 15 minutes (depending on system peripherals), allowing time for orderly system shut 
downs.

Figure 2-8 UPS Front View

The UPS is connected to the SPU via the dedicated UPS port on the Core I/O card. The SPU sends 
signals to the UPS and passes messages to the operating system of AC power conditions.

UPS Controls

Figure 2-9 shows the controls and indicators for a typical UPS:
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Figure 2-9 UPS Controls

The UPS Lights and Switches are:

1. AC Output (Green) Light - Indicates AC power is being supplied to the plugs at the rear of the UPS 
unit

2.  Battery Power (Yellow) Light - Indicates UPS is supplying power during abnormal AC power 
conditions.

3. Attention (Yellow) Light - Indicates that the UPS needs attention.

4. Silence Alarm/Test Switch - Lets user silence the alarm when activated an alarm condition, is also be 
used to test the UPS alarm system under normal operating conditions.

5. ON/OFF Switch - Controls power to output receptacles on rear of UPS.

NOTE Refer to your UPS PowerTrust Manual for complete front panel lights, switches, and 
operation information.

1. AC Output Light

2. Battery Power Light

3. Attention Light

5. ON/OFF Switch

4. Silence Alarm/Test
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SPU Major Components

Front View of SPU
Figure 2-10 shows the HP 9000 Model K4xx with the Front Bezel and Memory Bulkhead removed. At 
the top right is the LCD panel and SPU key switch. The LCD panel displays selftest and other system 
messages.

Figure 2-10 K4xx With Front Panels Removed.

1. SPU key switch

2. LCD Panel

3. Removable media slots

4. Processor 0 card

5. Slot for Memory Carrier 1

6. Memory Carrier 0
7. Power Monitor Card

8. Slot for Processor 1 card

9. Front Cooling Fan

10. Hard Disk slots
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Peripheral Drawer

To the left of the display panel is the Peripheral Drawer which contains two vertical slots for 
single-ended SCSI removable media devices and four horizontal slots for fast/wide/differential SCSI 
disk drives. These slots will accommodate 1/2 inch or 1 inch high hard drives.

Figure 2-11 Peripheral Drawer Removed from Cabinet

1. Upper peripheral
bay for removable
devices.

2. Lower peripheral
bay for fixed hard
disks.
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Processors and Power Monitor Card

Models K370/K380 and K570/K580 each have two front slots and four rear slots for the installation of 
SPU processors. The processors/slots are numbered 0 through 5. All SPUs are configured with the first 
processor in (front) slot zero (0). Processor 1, if installed, goes in the vacant front slot between slot 0 and 
the peripheral bay. See Figure 2-12. (Processors 2 through 5, if installed, go in slots at the rear).

Model K2x0, K360, and K4x0 each have two front slots and two rear slots for the installation of SPU 
processors. The processors/slots are numbered 0 through 3. All SPUs are configured with the first 
processor in (front) slot zero (0). Processor 1, if installed, goes in the vacant front slot between slot 0 and 
the peripheral bay. See Figure 2-12. (Processors 2 and 3, if installed, go in slots at the rear).

The Power Monitor plug-in card is mounted in the slot to the left of the Processors. See callout 1 in 
Figure 2-12 below.

Figure 2-12 Front Processors and Power Monitor Card

1. Power Monitor Card

2. Processor 0 (Zero)

3. Vacant connector
for Processor 1
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Memory

Memory for models K2x0, K3x0, K4x0, and K5x0 is located in one or more memory carriers. See 
number 1 and 2 in Figure 2-13 below. Memory for Model K100 (not shown) is located, on the system 
card, inside the rear of the chassis.

Memory is available as 16, 32, 64, 128, 256, or 512 MByte error correcting Single In-line Memory 
Modules (SIMMs). The SIMMs must be installed in pairs, called modules. Single processor SPUs can 
address up to 512 Mbytes or Random Access Memory (RAM). Multiprocessor systems can address up to 
8GBytes of RAM.

Figure 2-13 Memory Carrier Bay

1. Slot for Memory Carrier 1

2. Memory Carrier 0

3. Memory Carrier Bay
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Cooling Fans

Two variable speed fans supply cooling air to the SPU chassis. They are mounted at the bottom of the 
SPU cabinet (see callout 1 in Figure 2-14. One may be accessed from the front of the SPU cabinet and 
one from the rear.

The speed of the fans is controlled by the power monitor card. When ambient temperature inside the SPU 
cabinet rises, the speed of the fans increases, moving more cooling air.

To maintain adequate air flow and control RFI/EMI generated noise, all covers and bezels must be 
installed during normal operation.

Figure 2-14 Front Cooling Fan Location
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Rear View of SPU

The UPS, System Console, Networks and some external peripherals connect to the system via the Core 
I/O. The HP-PB panels also provide connectors to external peripherals.

Figure 2-15 shows the rear view of a Model K400/K410/K420. Models K100 and K200/K210/K220 are 
identical except that the Core I/O panel for the Model K100 is positioned two vertical slots to the left.

Figure 2-15  Model K400/K410/K420 Rear View

Figure 2-16 shows the rear view of a model K250/K260/K360/K450/K460. Note that the power supply is 
larger than other models and that the power supply bulkhead extends across the back of the rear 
processor slots.

Figure 2-16 Model K250/K260/K360/K450/K460 Rear View

1. HP-PB

2. Core I/O

3. HP-HSC Expansion I/O

4. Rear processor bulkhead

5. Power supply
sub-assembly

6. AC Power Input Socket

7. Rear fan access panel

1. HP-PB

2. Core I/O

3. HP-HSC Expansion I/O

4. Rear processor locations
(behind pwr supply flange)

5. Power Supply
Subassembly

6. AC Power Input Socket

7. Pwr Supply Fan Assembly

8. Rear Fan Access Panel
(behind the bottom panel)
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The rear view for models K370/K380 and K570/580 show a different configuration. Note the following 
differences compared to the K250/K450/K260/K360/K460 models (refer to Figure 2-17 and Figure 
2-18):

• The Core I/O board now occupies two slots formerly used for HP-PBs.

• The HSC Expansion I/O occupies the slot used for the Core I/O.

• Two slots formerly used for the HSC Expansion I/O are now used for additional processors. 
Alternatively, these slots may house a Dual Bus 4-slot HSC Expansion I/O for extended I/O 
capability (see Figure 2-18).

All rear mounted system components are accessible without removing cabinet "skins" except for the rear 
processors that are located behind the Rear Processors Bulkhead and the rear fan that is located behind 
the bottom panel.

Power Supply
At the far right of the SPU (callout 5, Figure 2-15 or callout 7, Figure 2-16) is the power supply, which is 
a removable assembly. Near the bottom of the power supply is the AC power input socket (callout 6, 
Figure 2-15 or callout 6, Figure 2-16).

HP9000/K2x0 and K4x0 Rear Processors
To the left of the power supply are the slots for the rear processors. See Figure 2-17. On models 
Kx50/Kx60/Kx70Kx80 the power supply bulkhead extends across the face of the slots for processors 02 
and 03 (see Figure 2-16).

Figure 2-17 Model K2x0/K4x0 Rear Processor Slots

1. Power Supply
Assembly

2. Slot for Processor 02

3. Slot for Processor 03



Chapter 2 2-17

Exploring Your Hardware
SPU Major Components

HP9000/K370/K380 and K570/K580 Rear Processors

To the left of the power supply are slots for the rear processors. See Figure 2-17. On models K370/K380 
and K570/K580, the power supply bulkhead extends across the face of the slots for processors 02 and 03 
(see Figure 2-16). Depending on the system configuration, additional slots are available for processors 
04 and 05 and for installation of a Dual Bus 4-slot Expansion I/O (see Figure 2-18).

Figure 2-18 Model K370/K380 and K570/K580 Rear Processors

NOTE The Dual Bus 4-slot Expansion I/O configuration is not available on K370 or K380 
models.
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HP-HSC Expansion I/O

There is space for an optional I/O carrier to the left of the processor slots (callout 3, Figure 2-15). The 
optional I/O expansion slot can be used for either a 2- or 4-slot HSC I/O expansion module. 

The 4-slot I/O Expansion module is available only for the HP 9000/K4x0/K570/K580 Systems. 

The 2-slot HSC I/O Expansion module is available for the HP9000 K370/K360/K380/K4x0/K570/K580 
system.

HP9000 K2x0 systems do not support any HSC I/O Expansion modules.

Figure 2-19  Expansion I/O
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Core I/O

The Core I/O is the main connector panel for the console, UPS, most external peripheral devices and 
network devices. 

Figure 2-20 Core I/O (K100/K200/K210/K220/K400/K410/K420)

1. LAN 802.3 via 10 Base-T or AUI

2. Internal modem port

3. Modem distribution panel connect

4. Expansion slot for single-wide,
snap-in adaptors

5. Fast/wide SCSI for external devices

6. Console RS-232 direct connect

7. UPS RS-232 control connect

8. Remote console RS-232 modem 
connect

9. Parallel (Centronics)

10. PS/2 mouse

11. PS/2 keyboard

12.Transfer of Control (TOC) switch.
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Figure 2-21 Core I/O (K250/K260/K360/K370/K380/K450/K460/K570/K580)

The expansion slot (Figure 2-18) will accept the following adapters:

• Fast/Wide SCSI adapter

• Graphics adapter

• High speed system connect (HP-HSC) to HP-PB bus adapter

1. LAN 802.3 via 10 Base-T or AUI

2. Internal modem port

3. Multimedia I/O jacks

4. Modem distribution panel connect

5. Expansion slot for single-wide, snap-
in adaptors

6. Fast/Wide SCSI for external devices

7. Console RS-232 direct connect

8. UPS RS-232 control connect

9. Remote console RS-232 modem 
connect

10. Parallel (Centronics)

11. PS/2 mouse

12. PS/2 keyboard

13. Transfer of Control (TOC) switch
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Core I/O Card Status LEDs

Core I/O cards have LED status indicators on the bulkheads. This section shows the location and 
interpretation of each Core I/O LED. To determine the status of a particular function on a card, locate 
and identify the LED (e.g., LINK Status, SCSI Selftest, etc.). Match the LED pattern with the 
descriptions in this section.

Table 2-4 Internal Modem Transmit/Receive LEDs

Figure 2-22 Internal Modem Transmit/Receive LEDs

Table 2-5 Internal Modem DCE Link Speed LEDs

Figure 2-23 Internal Modem DCE Link Speed LEDs

Internal Modem LED Data Activity

Transmit Callout (1) If blinking (or on) data is being transmitted

Receive Callout (2) If blinking (or on) data is being received

Internal 
Modem LED

14400bps 9600 bps 2400 bps
Other speed 

or no 
connect

9600 xxx (1) ON ON OFF OFF

2400 xxx (2) ON OFF ON OFF
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Table 2-6  LAN LEDs

Figure 2-24 Internal Modem LAN LEDs

Table 2-7 F/W SCSI/Diff SCSI Term Power LED

Figure 2-25 F/W SCSI Diff SCSI Term Power LED

LAN LED Description Function

Transmit xxx (1) Transmit LED Indicates transmit status of 10 
Base-T or AUI port. Turns on to 
indicate transmission. Blinks at a 
rate dependent on the level of the 
transmit activity.

Link Beat xxx (2) Receive LED Indicates receive status of 10 Base-T 
or AUI port. Turns on to indicate 
reception. Blinks at a rate dependent 
on the level of the receive activity.

Term Power LED State (1) Function

On Indicates that the F/W SCSI circuitry is 
supplying termination power.

Off The termination power fuse is blown, 
replace fuse.
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Table 2-8  MDP Selftest LED

Figure 2-26 MDP Selftest LED

MDP LED State (1) Function

Off LED will go off after a successful selftest.

Blinking LED blinks during the selftest.

On LED stays on during a hard reset or if selftest fails.
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HP-PB Slots

The Hewlett-Packard Precision Bus (HP-PB) slots are for connecting a wide range of external devices. 
The HP9000 K-class systems have double high slots and single high slots. The K4x0 has four double 
high and four single high slots, for a maximum of eight I/O cards. The K570/K580, K360, K370/K380, 
K2x0 and K100 have two double high and two single high slots, for a maximum of 4 I/O cards.

NOTE Double high slots can be used for either double high or single high I/O cards. For 
instance, if a K4x0 used no double high cards it could accommodate 8 single-high I/O 
cards; if it used 1 double high card it could accommodate 7 single high cards.

Figure 2-27 HP-PB Standard and Optional Slot (K4x0)

1. Double-high or single
high slots

2. Single high slots



Chapter 2 2-25

Exploring Your Hardware
Internal Peripherals

Internal Peripherals
The internal peripherals include the following:

• DDS Tape Drive

• 1, 2, 4, or 9 Gigabyte SCSI-2 Fast/Wide Disk Drives

• CD-ROM Drive

As listed above, the workstation comes with one internally mounted CD-ROM drive. Figure 2-29 shows 
the CD-ROM drive front panel. The eject button is pressed to open or close the tray for installation or 
removal of a disc. Table 2-9 shows the conditions indicated by the busy indicator.

Figure 2-28  CD-ROM Drive

NOTE Pressing the Eject button ejects the CD within five seconds. This button does not work if 
there is no power or if the software application has disabled the drive's eject operation. If 
the button is not working or disabled, you can still eject a CD via the Emergency Eject 
Hole. (Insert a straightened paper clip into the hole and push.)

1. Headphone Jack

2. Volume Control

3. Activity Indicator

4. Eject Button

5. Emergency Eject Hole
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Table 2-9 CD-ROM Drive Status Indicator

If the Busy indicator shows that the drive is inoperative, some possible causes are:

• No disk is inserted in the CD caddy.

• Disk is loaded with the label side facing downward in the caddy.

Busy Indicator Condition

Off CD Caddy ejected.

Fast Blink (0.2 Sec.) Indicates data transfer.

Fast Blink (0.8 Sec.)-Turns Off Ready for data read.

Fast Blink (0.8 Sec.)-Turns On Drive is inoperative.

Slow Blink (3.2 Sec.) Disk is dirty.

Slow Blink (1.6 Sec.) Audio playback.
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DDS Tape Drive

The optional DDS tape drive is located in the Peripheral Bay of your computer. Figure 2-29 shows the 
DDS tape drive.

Figure 2-29  DDS Tape Drive

There are two indicator lights on the front of the DDS tape drive. The upper light (callout 1) is the 
cassette light, and it indicates the status of the DDS tape cassette. The lower light (callout 2) is the drive 
light, and it indicates the status of the DDS tape drive. Each light is capable of displaying two colors: 
yellow or green.

DDS Indicator Light Tables

Table 2-10, Table 2-11, Table 2-12, and Table 2-13 illustrate the describe the various combinations of 
DDS tape lights and what each condition means.

Table 2-10 Tape Drive: No Cassette

Cassette Light
(Left)

Drive Light
(Right)

Condition

Off Off No cassette loaded or power off.

Off Pulsing Green No power or no cassette

Flash Yellow Flash Yellow Selftest in progress.

Steady Green Flash Green No cassette, SCSI activity.

1. Cassette Light

2. Drive Light

3. Cassette Slot

4. Unload Button
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Table 2-11  DDS Tape Drive: Tape Write-Enabled

Table 2-12 DDS Tape Drive: Write-Protected

Table 2-13 DDS Tape Drive: Error States

DDS Tape Cautions

NOTE Do not try to insert a DDS tape while the drive is conducting the selftest or the selftest 
will fail and the drive will not operate.

If the error states lights indicate a caution, it means that the DDS tape drive is having to correct an 
excessive number of errors when using the cassette. This can mean that the tape heads need cleaning, or 
that the DDS tape is nearing the end of its useful life.

When you see a caution signal, first clean the DDS tape heads. If the signal occurs again, you should 
copy the data from the DDS tape onto a new DDS tape as follows:

1. Copy the data from the DDS tape onto the hard disk.

2. Copy the data from the hard disk onto a new DDS tape.

3. Discard the old DDS tape.

Cassette Light
(Left)

Drive Light
(Right)

Condition

Steady Green Steady Green Cassette is loading and on line.

Steady Green Pulse Green Cassette is loaded and SCSI activity.

Pulse Green Pulse Green Loading, unloading, or ejecting

Steady Green Off Drive off line.

Cassette Light
(Left)

Drive Light
(Right)

Condition

Steady Yellow Steady Green Cassette is loaded and on line.

Steady Yellow Flash Green Cassette is loaded and SCSI activity.

Steady Yellow Off Drive off line.

Cassette Light
(Left)

Drive Light
(Right)

Condition

Steady Green Pulse Green/Yellow Caution (Media Warning).

Steady Yellow Steady Yellow Condensation detected, or no 
termination resistors.

Pulse Yellow Steady Yellow Fault (Diagnostic Failure).
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Handling and Storing Data Cassettes

Environmental conditions can affect the reliability of data stored on cassette tapes. It is recommended 
that you use only cassettes marketed by Hewlett-Packard, which meet high standards.

To ensure data integrity for your cassettes, follow these guidelines:

• Do not touch the tape, nor attempt to clean the tape path or tape guides inside the cassette.

• Do not leave cassette tapes in excessively dry or humid conditions.

• Do not leave cassette tapes in direct sunlight or in places where magnetic fields are present (for 
example, under telephones or near transformers).

• Do not drop cassettes, nor handle them roughly.

• Do not stick more than one label onto cassettes; extra labels could cause the cassettes to jam in the 
DDS tape drive.

• Store cassettes in their plastic cases when not in use.

• Always store the cassettes in a clean environment.

• Do not use cassettes when the caution signal is displayed by the cassette (upper) light, located on the 
front panel. The light shows a repeating pattern of: green for 4.5 seconds, then off for 0.5 seconds. If 
the light pattern appears, it means that the tape heads need cleaning or that the DDS tape is nearing 
the end of its useful life.

NOTE Insert the DDS tape with the arrow on the tape pointing towards the drive.
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3 Starting Your Computer 

This section of the manual covers the steps necessary to make full use of the HP 9000 System 
immediately prior to and after applying power. The steps are:

• Setting Core System Component Switches prior to applying power.

• Modifying Firmware settings after applying power

• Turning over control to the operating system.

Setting Core System Component Switches Prior to 
Applying Power 

Uninterruptible Power Supply 
Place the UPS Power Switch in the down position (OFF). See Figure 3-1.

Figure 3-1 UPS Power Switch in the "OFF" Position
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SPU 

Turn the key switch to the "Standby" position.

Figure 3-2  Key Switch in the "Standby" Position

System Console 
Push the On-Off switch so that the switch is in the Off position, flush with the front panel.

Figure 3-3 System Console in the OFF Position

Power On Sequence 
Turn the system on in the following order:

1. Turn on the UPS. Push the top of the switch in.

2. Turn on the System Console. Push the ON/OFF switch in.

3. Adjust the Contrast and Brightness for a visible cursor display.

4. Set the System Console mode.

5. Turn on all connected peripherals and ensure that they are running with no error indications.

6. Turn on the SPU by placing the key switch in the "ON" position.
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The following actions occur simultaneously:

• The UPS LED indicators light up

• The LCD on the SPU displays system messages

• The System console displays the progress of the boot process

System Console Modes 

The System console is a general purpose terminal that can be used in many different ways. There are two 
ways that it can be used as a System Console:

• Direct Mode

• Remote Mode

Direct Mode Operation 

The console is directly connected to the HP 9000 SPU via the Core I/O card console connection.

Remote Mode Operation 

The console is connected via a modem to the remote console connection on the Core I/O cord.

UPS Status 
The UPS displays status conditions via a combination of LED status indicators (see Figure 3-4) as 
follows:

1. AC Output Indicates that normal AC power is being supplied to the receptacles in the back. (Green)

2. Battery Power Indicates the unit is supplying power during abnormal power (AC) conditions. (Yellow)

3. Attention Light Indicates that the UPS needs attention. It also works in conjunction with the audible 
alarm. (Yellow)

NOTE Refer to your UPS PowerTrust Manual for complete front panel lights, switches, and 
operation discussion.
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Figure 3-4  UPS Status Indicator

LCD System Status Messages 
The LCD panel displays messages during the boot process. A series of key words, generically called 
OSTAT in Table 3-1, appear in the LCD panel as the system does its selftest. Table 3-1 explains what you 
see in the LCD panel during selftest.)These OSTAT values in column 1 of Table 3-1 can be any one of 
the following:

After this sequence has finished, the system prompt will appear on your console to indicate that the 
sequence is complete and the Operating System has been successfully loaded. At the system prompt you 
will configure your system, set your root password, add users and groups, etc.

OSTAT Value Meaning

OFF key switch in Standby position

FLT fault

TEST selftest

INIT initialize

SHUT shutdown

WARN warning

RUN normal operation

ALL
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Table 3-1 LCD Panel Messages

System Console Displays at Power-On 

The SPU internally checks itself and displays the test results.

The SPU executes firmware code that tests all internal major functions and displays all test results.

The SPU reads firmware code default settings initially set at the factory. On subsequent boots, the SPU 
executes user settings if default settings are modified.

The firmware code turns control of the System to the Operating System.

NOTE You may not be able to read all screens because of the speed at which they change. You 
can review all screen displays at the conclusion of the boot process.

Panel Message Environment Observations

[blank] Key switch in Standby. 
No power cord.

Blank display. LCD Panel 
backlight is off.

SWITCH OFF xxx Key switch in Standby. 
Power cord installed.

AC power installed, LCD 
panel back light is off. 
Front panel displays 
SWITCH OFF.

PROCEEDING TO 
xxx TURN DC ON

Key switch is ON Display panel shows 
message, LCD panel back 
light comes on 1 to 2 
seconds after display starts.

OSTAT XXXX xxx Key switch is ON. 
Processor Dependent 
Code (PDC) is loading.

Ostats and chassis codes 
are being displayed at the 
panel and console banner. 
Chassis codes may range 
from 0000 (hex) to CDFF.

OSTAT XXXX xxx 
CPU ZZZZ

Key switch is On. ISL 
is running.

System initialization codes 
are being displayed. OS or 
Diag loading can be 
started. Codes may range 
from CE00 (hex) to CEDF. 
CPU ZZZZ shows 
processors installed. 

OSTAT XXXX xxx 
CPI ZZZZ

Key switch is On. OS 
load in process.

OS is loading from disk or 
tape. Codes may range 
from CEE0 to CFFF.

RUN FXYF xxx 
CPU ZZZZ

Key switch is On. OS 
load is complete. OS is 
running.

The OS is finished loading. 
The ’X’ after RUN = CPU 
utilization. The ‘Y’ = the 
number of processors.



3-6 Chapter 3  

Starting Your Computer
Viewing/Changing Firmware Choices

Viewing/Changing Firmware Choices 

CAUTION Be very careful about making changes via the PDC menus, especially with the 
Configuration and Service menus, as those changes may disable your computer.

Introduction to Firmware Configuration 
Firmware is system configuration instructions which are embedded in hardware. Firmware is modified 
by commands from the keyboard which are retained in semiconductor memory when power is removed. 
Firmware is not as easily modified as software nor as permanent as hardware, hence the term firmware.

• Firmware as implemented on HP systems:

• Can be automatically configured by "reading" the parameters of drives such as hard disks

• Defaults to standard configurations established during manufacturing

• Can be modified by users

• Retains the last user choices when the system is rebooted or power is interrupted.

Entering Configuration Menus from HP-UX 
Once the HP-UX operating system is operational, you need to perform the following steps to enter the 
configuration menus. These procedures will halt all system functions and reset the computer, use caution 
while performing these procedures.

1. Log onto the system as root, and enter reboot -r. This command will shutdown the operating system 
and reboot the computer.

2. If AUTOBOOT is on, you will receive the following message:

Process is starting autoboot process To discontinue, press any key within 10 seconds

At this point, press ANY KEY within 10 seconds to interrupt the booting process.

CAUTION If you DO NOT interrupt the boot process within the 10 second window, you MUST 
allow the computer to complete the bootup process, then go back to step 1 and repeat the 
interrupt procedure.
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3. The MAIN MENU is displayed. A prompt will appear as

MAIN MENU: Enter command or menu

The Main Menu displays:

Figure 3-5 Main Menu 

Main Menu
The Main Menu is divided into three sections:

• System Commands

• Menus

• Display and Help Commands

To use a command, type the characters shown in capital letters and press [RETURN] . For example, to boot 
from the primary boot path, type: BO and press [RETURN]. You can use the upper or lower case (bo or 
BO).

NOTE The Menus and Helps shown in these examples will vary slightly on HP9000 
K250/K260/K450/K460 systems due to new firmware features.

Main Menu

-------------------------------------------------------------------------------------------------

CommandDescription

--------------------------

BOot [PRI|ALT|<path>PAth 

[PRI|ALT|CON|KEY|<path>

SEArch [Display|IPL] [<path>]

COnfiguration menu

INformation menu

Boot from specified path

Display or modify a path

Search for boot devices

Displays or sets boot values

Displays hardware information
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Configuration Help

The help command is used with any other command to guide you in using the command correctly. For 
example to get help with the Boot Command you type:

HE BO

The following information is presented:

Figure 3-6 Boot Help Information

PATH displays the system path from Stable Storage. PATH is also used to set a named path in Stable 
Storage.

BOOT Continues the boot sequence

from the specified path.

The primary boot path is normally the 

disk containing the operation system.

The alternate path is normally a tape device.

BOot 
BOot PRImary
BOot ALTernate 
BOot INSTALL

BOot    %<path>
%<path> 

Boot from primary path
Boot from primary path
Boot from alternate path
Boot from HP-UX Install server 
using Core LAN station
Boot from specified mode

is either in I/O notation,
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Figure 3-7 Path Help Information

NOTE The Keyboard path cannot be modified.

Figure 3-8 Search Help Information

PAth Display paths in

Stable Storage

PAth <path type> Display named path

PAth <path 
type>%<path>

Set named path in

Stable Storage

<path type>

<path>

PRImary, ALTernate,
CONsole or KEYboard
is in I/O notation,
such as 1/2/3.4/5/6

Short Command for PAth PA

SEArchSearch for all
potential boot
devices
SEArch <path>Search specified
path for
potential boot
devices
SEArch IPLSearch for all
bootable devices
with IPL
SEArch IPL <path>Search specified
path for
bootable devices
with IPL
SEArch DIsplayDisplay the
results of the
previous search

<path> is a module path defined
in I/O notation, such as 1/2/3/
or 8 (layers are ignored).

The first 20 devices found
will be displayed.

The devices found will have a path label
such as P0, P1, .  .  .  p19 that may be
referred to in the BOot  command or will
be displayed on a SEArch DIsplay
command.

Short Command for SEArch SEA
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Figure 3-9 Display Help Information

Figure 3-10 Help Help Information

Figure 3-11 Reset Help Information

Changing Menus:  To access the other menus, simply type the capital letters and [RETURN]. For example 
to access the Configuration Menu, type:

CO [RETURN]

DISPLAY redisplays the current menu.

Short Command for DIsplay       DI, LS, L

Type HELP %<command> or %<menu> for more help.

Type DIsplay to redisplay the
current menu commands.

Short Command for HElp          HE, ?

RESET resets the machine state.  It resets the
processor, causing a hard boot to be initiated,
which is similar to power-cycling the machine.
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Configuration Menu

The Configuration Menu is divided into two sections:

• Configuration Commands

• Boot Display and Help Commands

Configuration Commands

These commands are used to display or change basic system parameters.

Boot/Display and Help Commands

You can reboot, redisplay the current menu or get Help on any of the Configuration Commands.

Figure 3-12 AUTO Help

Figure 3-13 BOOTINFO Help

AUTO displays or sets the AUTOBOOT and
AUTOSEARCH flags in Stable Storage.
These flags control the automatic
boot sequence.

If the AUTOBOOT flag is set,
the operating system is
automatically loaded
after a power-up or reset.

If the AUTOSEARCH flag is set,
the system searches for
all possible boot devices.

AU Short Command for AUto
AUto Display the state of

AUTOBOOT/AUTOSEARCH
flags

AUto SEArch ON Turn on AUTOSEARCH
AUto SEArch OFF Turn off AUTOSEARCH
AUto BOot ON Turn on AUTOBOOT
AUto BOot OFF Turn off AUTOBOOT

BOOTINFO displays system configuration
information related to booting that is
stored in non-volatile memory.

Short Command for BootInfo      BI
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Figure 3-14 FAST BOOT Help

NOTE The recommended setting is OFF.

Figure 3-15FAN Help

FASTBOOT speeds up system boot time by
executing a quick memory test which only
reads memory (rather than writing to memory)
and skipping selected other tests.

FastBoot            Display current setting of
                    Fastboot
FastBoot ON         Turn Fastboot on
FastBoot OFF        Turn Fastboot off

Short Command for FastBoot      FB

FAN changes the fan speed to high
or normal speed setting.  This setting
is saved in eeprom and will remain set
even if the system is rebooted.  Only if
the speed is changed again will the
setting be altered.

FAn                 Display the current
                    fan speed
FAn HIgh            Set the fan speed to
                    HIGH speed
FAn NORmal          Set the fan speed to
                    vary with temperature

Short Command for FAn           FA



Chapter 3 3-13

Starting Your Computer
Viewing/Changing Firmware Choices

Figure 3-16 DEFAULT Help

Figure 3-17 LANADDRESS Help

DEFAULT initializes system
Stable Storage values to
their defaults based on the
system configuration.

The DEFAULT command sets
the following values:

   Primary Path      10/0.6

   Alternate Path    10/12/5.0

   Console Path      10/4/0.0

   Keyboard Path     10/12/7.0

   Autoboot          off

   Autosearch        off

Short Command for DEfault        DE

LANADDRESS command displays the Core LAN
Station Address.

LanAddress        Display the Core
                  LAN station address

Short Command for LanAddress     LA
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Turning Over Control to the Operating System 

NOTE If your graphics console is not working at this point, see "Your Graphics Console Doesn't 
Work" in Chapter 4.

Operating System Wasn't Pre-installed 
If your computer has preloaded software (HP VUE and the HP-UX operating system are loaded on the 
hard disk at the factory), the computer is shipped with a yellow sticker covering the power switch. If 
there was such a yellow sticker, then skip to "You Have a Login Prompt on Your Console".

The HP9000 Series 800 Model K normally comes with the operating system pre-installed on an internal 
hard-disk drive. If you have ordered your system without the internal disk drive, or if you chose to 
re-install the operating system, you will need to follow the instructions presented in Installing HP-UX 
10.xx.

Essentially, you will type a BO command at the PDC main menu prompt and specify which drive you are 
booting from. There will be a delay between typing the installation command and the time that you will 
notice any disk activity. This delay could be between two and three minutes. Do not turn off the power, or 
try to cancel the installation process during this period.

The media on which you received your operating system requires no code word to install the operating 
system. Code words may be required, however, for accessing and installing other software.

You Have a Login Prompt on Your Console 
You have reached the final step of your installation.

Getting Required Information 
Before you can complete your installation, you should know the following information. The system 
needs this information so that it can configure certain system and networking parameters.

NOTE If you do not have some of this information now, such as the host name or Internet 
address, you can add or modify it later. Such modifications should be made as soon as 
possible after initial installation. For instructions, see "Modifying System Parameters".

• The host name of your computer (sometimes called the system name). The host name can be a simple 
name or an Internet fully-qualified name. Get the host name from your system administrator.

• Host name : ___________________________________

• If you are connecting your computer to a local area network, you need to know your computer's 
Internet Protocol address (IP or Internet address). This is a four-part code (for example, 15.15.232.18) 
that uniquely identifies your computer among all those located on your network or any other network. 
Obtain this address from your system administrator.

• IP Address: ___________________________________
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• The time zone where your computer is located (for example, Mountain Daylight Savings Time). You 
don't need to know the standard abbreviation.

• Time zone: ___________________________________

• The root password. Be sure to write it down in a secure place. You will use this password when you 
log in as superuser later in this chapter. If you choose not to select a superuser password, you may do 
so later.

NOTE The root user, or superuser, is a special user. When logged in as the superuser, you have 
the permission required to perform all system administration tasks. Normally, the system 
administrator is the only one who logs in as the superuser. The user name for the 
superuser is root.

However, the very first time you (or anyone else) log into your new workstation, you must 
do so as root because no other user accounts have been created yet. Once accounts have 
been created for other users, you should log out as superuser, then log back in as one of 
those users.

For more information if you are using HP-VUE on a Graphics Monitor, see HP VUE's online help. Click 
the Help Manager control (the books and question mark icon) on the Front Panel at the bottom of your 
screen. Then click HP-VUE Help, then click "General Configuration", then click "Network Font Server". 
Also see the mk_fnt_clnt(1)  and mk_fnt_srvr(1)  manual reference pages.

Entering the Required Information 
A series of windows appear that prompt you for the information about your computer that you gathered 
in the previous section, such as your host name, IP address, time zone, and root password. Enter this 
information as it is requested.

If you do not set a host name now and instead accept the default host name of unknown, you will get an 
error message when you log in.

NOTE If you do not have the information when prompted for it, press [ENTER] . HP-UX then uses 
its default value for that question, and you can add or modify the information later. Such 
modifications should be made as soon as possible after initial installation. For 
instructions, see "Modifying System Parameters".

• When you have finished answering the questions, the computer completes its startup sequence.

• Once your computer is running, it will display one of two ways to log in the HP VUE login screen or 
a command line prompt. In either case, enter your login name and then your password.
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Modifying System Parameters 
Use this section only if you need to add or modify the system parameter information described in 
"Getting Required Information".

Log in as the superuser and type the following command in a terminal window:

/sbin/set_parms option[ENTER]

Where option is one of the following:

If you are running HP-VUE on a graphics monitor, you can set network parameters or network font 
service using the icons labeled SetNetworking  and FontClientSrvr , located in the General 
Toolbox in the System_Admin subdirectory.

Any changes you make in set_parms  will take effect after rebooting the system.

You can also use SAM to add or change most of this information.

Option Command Modifies or Sets

hostname System host name

timezone Time Zone

ip_address Internet Protocol address

addl_network Additional network parameters (see pate 1-7)

font_c-s Network font service
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What if something doesn't work correctly? 

• The first step should always be to go back to the installation guide and double-check that every 
connection location is correct, and that you have used the correct cables for each connection. There 
are some cables that look the same and have the same connectors, but are wired differently internally; 
so you must use the cable with the correct part number.

• If you are not getting power to your SPU, make sure that the outlet you are using is active. You might 
do this by plugging in a table lamp to see if it works. Some outlets are controlled by wall switches. 
Other outlets may have been inactivated at a breaker box. Check with your facilities engineer about 
getting power to your computer. Make sure all power cables are firmly attached to the computer and 
UPS as well as the wall outlet.

• Check the indicator LEDs on the UPS and the Core I/O to see if they are indicating that there is any 
inappropriate hardware behavior. Check status indicators on all internal and external peripherals. 
Information about diagnostic indicators and display messages can be found in UPS Controls, Core 
I/O Card Status LEDs, and DDS Indicator Light Tables in Chapter 2, in Appendix D- UPS Error 
Messages, in your PowerTrust manual, and in the manuals that come with your peripherals.

• Contact your HP Sales Engineer or an HP Support person via the number on your service contract. 
Your HP representative may want to know the status of the led indicators, or may want you to connect 
your computer's internal modem to a phone line. See Internal Modem Random Access later in this 
chapter.

Internal Modem Remote Access 
This section provides the information on enabling or disabling the remote access through the internal 
modem.

NOTE The HP50759A|B modem cannot be used to dial in to the internal modem.

The following procedures are applicable only if HP Predictive has not been installed. If 
HP Predictive is installed, use Predictive to configure the internal modem for remote 
access. Refer to the Predictive Support User's Guide (part number 50779-90018).

Enabling and Disabling Remote Access 
The remote access process is provided through a script called dialin. The syntax for running the dialin 
script is:

>dialin [-bbaud] action
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Where:

dialin  Is the HP-UX script

[-baud]  Can be used to specify a baud rate (Do NOT change the default baud rate)

action  Is one of three choices: enable, disable, status

Example of enable remote access:

>dialin enable  Enables remote access and uses the default baud rate or dialin status
Displays current status, either disabled or enabled

>dialin status  Displays current status, either disabled or enabled

CAUTION Do not use a baud rate other than the default of 19200 KBS. Other baud rates could cause 
the dialin process to malfunction.

The system then displays messages similar to the following:

Created device:/dev/cul0p7

Created device:/dev/ttyd0p7

Created device:/dev/cua0p7

Dialin enable

To disable remote access, use the disable action with the dialin command. The status action will display 
the current state of either enabled or disabled for remote access.
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Your Graphics Console Doesn't Work 
If you have just attached a graphics console to your Core I/O card and you get no response from it, check 
for the following:

• The graphics console is not turned on.

• The cable connected between the Core I/O card and the graphics console is not the correct cable. (The 
graphics console uses a different cable from the normal terminal console. Refer to the Installation 
Guide.)

• The graphics console is on, but the brightness or contrast on the graphics console are not adjusted 
correctly, and the display is too dim to see.

• The console address path is incorrect for your console I/O card. See the "Incorrect Graphics Console 
Address Path" section that follows.

Incorrect Graphics Console Address Path 
If the internal address path is incorrect, you can change it by rebooting your computer and then, during 
the PDC processing, setting the console address path to the location of your graphics card. The default 
location for this card is the Optional I/O (HSC) connector. The internal address for this HSC connector 
location is:

Change the path by:

1. Attaching a non-graphics terminal, such as an HP700/60 terminal.

2. Rebooting.

• Turn the SPU key to the Standby position.

• Turn the SPU key to the On position.

3. Halting the boot process at the PDC Main Menu.

• Watch the bootup messages carefully.

• There will be a message that says you have 10 seconds to press any key to stop the boot process; 
press any key.

• The PDC main menu will appear.

4. Changing the console address path.

• Find out what the correct address path should be; some defaults are mentioned in the list above, or 
you can look in Appendix C - Model K Address Paths

Model Address Path

K100 8/8.0

K2x0/K4x0 10/8.0



4-4 Chapter 4  

Troubleshooting
Maintaining Your DDS Tape Drive

• At the PDC Main Menu prompt type: pa con 10/8.0 (for K400 default)

5. Resetting your computer.

• At the PDC Main Menu prompt type: reset

• Your computer will reboot and, if everything has worked correctly, you should start seeing 
messages on the graphics console.

If you have followed all the above suggestions and your graphics console still does not work, please 
contact your Hewlett-Packard representative.

Maintaining Your DDS Tape Drive 
Your tape drive heads should be cleaned after each twenty hours of tape read/write operation.
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Systems 

NOTE See HP9000/Kxx0 Internal Peripheral Upgrade Guide, P/N A2375-90008 for 
adding/installing internal peripherals such as CD-ROMs, DDS Tape Drives, or SCSI Disk 
Drives. (See Internal Peripherals in Chapter 2 for a description of internal peripheral 
products.)

NOTE Connecting a graphics console requires that you first boot your Model Kxxx with a 
standard RS232-type terminal attached, change the address path (use the pa command 
from the main PDC menu) to the location where your graphics console is connected, and 
then reboot. Address paths are listed in Appendix C - Model K Address Paths.

The following two steps are required to add peripherals:

• Connecting the peripheral to your computer.

• Configuring your operating system to recognize the peripheral.

Peripherals include terminals, modems, printers, and a UPS, and are connected to your computer through 
three I/O panels on the back of the SPU: Core I/O, Expansion I/O, and HP-PB. The Core I/O panel is 
labeled to identify the function of each of its connectors. Printers, for instance, are usually parallel 
devices and attach to the parallel (Centronics) connector on the Core I/O panel.
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Terminals 

Connecting a Terminal 
Terminals will be connected to your computer differently depending on the model of the terminal. 
However, you must complete the following three steps for all terminals:

• Connect the monitor and keyboard together with the appropriate cable.

• Connect the data cable from the monitor to an appropriate connector on the Core I/O.

• Connect the power cord from the monitor to the power outlet or UPS.

You must set the default operating parameters on each terminal to match the requirements of your 
computer before you can use it.

Configuring the Operating System for a Terminal or Modem 
Make sure that the terminal or modem is physically connected to a port on your computer's serial 
interface before continuing.

Use the System Administration Manager (SAM), to configure your terminals and modems. Start the 
SAM by typing [s a m ] (in lower case) at the superuser prompt. Press [CTR] [K]  for help information 
about the SAM.

Choosing items from the "Help" menu gives you information about:

• the current functional area.

• keyboard navigation within the SAM.

• using the SAM help system.

• displaying the release of the SAM that you are currently running.

Use the Help menu to get information about the attributes and tasks you can perform from the currently 
displayed screen.

Pressing the [F1] key gives you context-sensitive information for the field at the location of the cursor. 
Exit the SAM by activating the Exit SAM  button from the SAM main screen. If you have performed tasks 
that require the generation of a new kernel, the SAM will prompt you to regenerate the kernel and reboot 
the system.

To configure HP-UX for a new terminal: 
Use the arrow keys to move the highlight to the desired option the Press the [RETURN] key to display a list 
of available options or select an option. You can press [F1] for additional information (Help screen) about 
these fields. Press [F5] to close the Help screen.

1. Log on as root .

2. Type sam.

3. Highlight Peripheral Devices  and press [RETURN].
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4. Highlight Terminals and Modems  and press [RETURN] .

5. At the Terminals and Modems  screen, use [Tab] to go to the menu bar.

6. Use the arrow keys to move the highlight the Actions menu  then press [RETURN].

7. Highlight the Add Terminal  option and press [RETURN].

8. In the "Add Terminal (Hardwired Device) " screen, set or select the following parameters:

a. Hardware path sets the path to the serial interface to be used by this terminal.

b. The port number to be used by this terminal. When Port Number is highlighted, press [RETURN] to 
see a list of available ports.)

c. The speed (baud rate) to be used by this terminal. The most common rate is 9600. When Speed,  
is highlighted on the screen, press [RETURN] to see a list of available baud rates.

d. Whether or not this will be a UUCP connection. When Use for UUCP Connection  is 
highlighted, successive presses of [RETURN] will select the UUCP choice.

When you finish setting the parameters, activate OK. (Either press [F5] or tab to OK and press 
[RETURN].)

9. You will receive a series of messages indicating the progress of the task. When you receive the 
message, The terminal has been added. , activate OK.

10.Exit the SAM by pressing [F8] /Exit , and then [F8]/Exit Sam , or by tabbing to the File menu and selecting 
successively Exit  and Exit Sam .

To configure HP-UX for a new modem: 

1. Log on as root .

2. Type sam.

3. Highlight Peripheral Devices  and press [RETURN].

4. Highlight Terminals and Modems  and press [RETURN] .

5. At the Terminals and Modems  screen, press [Tab]  to go to the menu bar.

6. Use the arrow and [RETURN] keys to select the Actions  menu.

7. Use the down arrow key to highlight Add Modem and press [RETURN].

8. In the Add Modem screen, set or select the following parameters:

a. The hardware path to the serial interface to be used by this modem.

b. The port number to be used by this modem. (When Port Number…is highlighted, press Return to 
see a list of available ports.)

c. The speed (baud rate) to be used by this modem. When Speed (Baud Rate)  is highlighted, 
press [RETURN] to see a list of available baud rates.)

d. Whether of not this modem will be used for calling out from your system. (Press [RETURN] to turn 
the Calling Out selection on/off.)
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e. Whether or not this will be a UUCP connection, and which modem type you will use. Press 
[RETURN] to turn the UUCP selection on/off. If you specify a UUCP connection, a list of modem 
types will appear for selection. To select a modem type, [Tab]  to the Modem Type:  area of the 
screen and then use the arrow keys to highlight your choice. Then [Shift-Tab] to return to the 
Receive Incoming Calls  item.

f. Whether or not this modem will receive incoming calls. Press [RETURN] to turn the Calling In  
selection on/off.

g. Select whether or not this is a CCITT Modem (European standard modems). Press [RETURN] to turn 
the CCITT Modem selection on/off.

When you finish setting parameters, activate OK by pressing [F5] or tabbing to OK and pressing 
[RETURN].

9. You will receive a series of messages indicating the progress of the task.

When you receive the message:

This modem has been added

activate OK.

10.Exit the SAM by pressing Exit  [F8] then Exit Sam  [F8] or by tabbing to the File menu and selecting first 
Exit  then Exit Sam .
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Adding Printers 
To add a printer to your computer:

• Physically connect the printer to the computer.

• Configure the operating system to recognize the printer.

Connecting a Printer 
Printers are connected to your computer differently depending on the model. Refer to the instruction 
manual for your printer. You must complete the following steps for all models:

• Connect the data cable from the printer to a connector on the distribution cable or data distribution 
panel for a serial printer, or directly to the computer for a parallel printer.

• Connect the power cord from the printer to the power outlet.

• Load paper into the printer.

• Turn on the printer.

• Put the printer on-line.

Configuring the Operating System for a Printer 
Use the System Administration Manager (SAM), to configure your printer. Start the SAM by typing sam 
(in lower case) at the superuser prompt. Pressing [Ctrl-K]  gives you help information about the SAM.

Choosing items from the Help  menu gives you information about:

* The current functional area.

* Keyboard navigation within the SAM.

* Using the the SAM help system.

* Displaying the release of the SAM you are currently running.

Activating the Help button when it is available gives you information about the attributes and tasks you 
can perform from the currently displayed screen.

Pressing the [F1]  key gives you context-sensitive help for the field at the cursor location. If you have no 
[F1]  key you can type [Ctrl-F]  to access context-sensitive help.

Exit the SAM by pressing the Exit SAM  button on the SAM main screen.

If you have performed tasks that require the generation of a new kernel, the SAM will prompt you to 
regenerate the kernel and reboot the system.

To add a local printer:

1. Physically connect the printer(s) to your system. Refer to the instructions shipped with your printer. 
Some printers have to be set for serial or parallel operation. If you need additional configuration 
information, refer to the Installing Peripherals manual.
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2. Gather the following information:

• The name you are giving to this printer or plotter. Printer names can be up to 14 characters in 
length, and the characters must be from the set (A-Z, a-z, 0-9). The underscore (_) character is 
also allowed in printer names.

• The name of the device file that the printer or plotter will use.The SAM creates the device file for 
you. The SAM uses the default device file named lp_printer-name. You can override the default 
device file name by specifying your device file name when filling in the printer information.

• The model script from the /usr/lib/lp/model directory, for example, uses laserjet4Si for the HP 
LaserJet 4 Si.

• The print request priority for this printer. The default is zero (0).

• The class to which the printer/plotter will be added (optional). Printer class names can be up to 14 
characters in length, and the characters must be from the set (A-Z, a-z, 0-9). The underscore (_) 
character is also allowed in printer class names.

3. Type sam.

4. Highlight Printers and Plotters -> and press [RETURN] .

5. Highlight Printers and Plotters and press [RETURN].

6. Choose, Add Local Printer/Plotter  from the Actions menu, and then choose the sub-menu 
item associated with the printer interface type that you will be using.

In addition, decide whether or not to make this printer your system's default printer.

NOTE The printer driver must be part of the kernel to add the printer. If the printer driver is not 
currently configured into the kernel, the SAM prompts you to add the driver(s) and reboot 
the system.

* Highlight the interface to which you connected the printer, fill in any additional information (port 
number or bus address), and activate the OK button.

If there are no I/O cards listed, activate the Diagnose Missing Card button and follow the instructions 
provided on the screens.

1. Fill in the add a local printer  dialog box fields, choose from the menu button values, and 
select check box values by pressing the [RETURN] key.

2. Activating the Help button, or pressing [Ctrl-K] , gives you information about the attributes and tasks 
you can perform from the currently displayed screen.

3. Pressing the [F1] key gives you context-sensitive information for the object field at the location of the 
cursor. If you have no [F1] key you can type [Ctrl-F]  to get context-sensitive information.

4. Press the OK button and respond appropriately to any dialog about the spooler, or about connecting 
and powering up the printer.

5. the SAM will return you to the, Printers and Plotters  screen.

Exit the SAM by selecting Exit  from the File menu on the current screen, and then Exit SAM  from the File 
menu on the next screen.
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Configuring the Operating System for the Optional UPS 
If you have the optional UPS, you must configure the operating system to recognize the port on the Core 
I/O where the UPS data cable is connected.

The SAM can be used to configure the operating system for the UPS. Type sam at the prompt to start the 
SAM. Select Peripheral Devices-> and then UPS. Follow the instructions on the screen for 
configuring your UPS.

If your site commonly experiences momentary power interruptions greater than one minute, consider 
increasing the value of shutdown_delay_mins  from its default value of one minute.

The default time for shutdown_timeout_min s is five minutes. If shutdown is longer or shorter than 
this time, consider changing the default time.

If a system shutdown has been initiated by the UPS, you must wait for the UPS to turn itself off before 
attempting to reboot your system.

Adding Other Peripherals 
The procedure for adding additional peripherals to your computer is different for each peripheral. Follow 
the instructions which come with each new peripheral. For assistance, refer to the HP-UX Reference for 
information on commands, or to the manuals that discuss the following topics:

* System Administration Tasks or Concepts

* Configuring or Installing Peripherals

* See the on-line manuals page for ordering information. You can access this page by typing:

man manuals

Working with the File System 
At a later time, you may need to make changes or additions to your file system. Before you do this, study 
the manuals listed below and carefully analyze your computer system, and your present and future needs.

HP-UX supports the Logical Volume Manager, which provides you with great flexibility in disk space 
management.

For assistance, refer to the HP-UX Reference for information on commands, or to manuals that discuss 
the following topics:

• System Administration Tasks or Concepts

• Installing or Updating HP-UX

See the on-line manuals page for ordering information. You can access this page by typing:

man manuals

Chapter 6, Adding and Modifying Users and Groups provides instructions for adding users and groups.
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Adding and Modifying Users and Groups 
Before anyone can be given access to the computer, they must be identified to the operating system as 
users. When a user is first added to the computer, you will assign a specific home directory. Users are 
organized into groups with other users who have similar requirements for operating system resources, or 
who regularly share programs or files.

Using the SAM 
Use the System Administration Manager (SAM), to add users and groups. Start the SAM by typing sam 
(in lower case) at the superuser prompt. Pressing [Ctrl-K]  gives you help information about the SAM.

Choosing items from the Help menu gives you information about:

• The current functional area.

• Keyboard navigation within the SAM.

• Using the SAM help system.

• Displaying the release of the SAM you are currently running.

Activating the Help button when it is available gives you information about the attributes and tasks you 
can perform from the currently displayed screen.

Pressing the [F1]  key gives you context-sensitive information for the field at the location of the cursor. If 
you don't have a [F1] you can access context-sensitive help with the [Ctrl-F]  key combination.

Exit the SAM  by pressing the Exit SAM  button on the SAM main screen.

If you have performed tasks that require the generation of a new kernel, the SAM will prompt you to 
regenerate the kernel and reboot the system.
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Adding Users 
1. Ensure that you have superuser capabilities.

2. Type sam.

3. Using the arrow keys, highlight the Accounts for Users and Groups  option and press 
[RETURN]. This displays the Accounts for Users and Groups sub-area.

4. Highlight Users  and press [RETURN]. This takes you to the Accounts for Users  screen.

5. Choose Add from the Actions menu.

6. Fill in the Add a User Account  screen fields and press the Apply  button.

7. Enter a starting password and press [RETURN] or press the OK button.

8. When prompted, re-enter the password and press [RETURN] to verify the initial password. You will be 
returned to the Add a User Account  screen.

9. When you are finished adding users, tab down to the Cancel button and press [RETURN] to select it. You 
will be returned to the Accounts for Users and Groups  screen.

You have now completed adding users.

To return to the Accounts for Users and Groups  functional sub-area, choose Exit  from the 
File menu and press [RETURN].

To return to the Functional Area List , highlight go up and press [RETURN].

To exit the SAM, highlight the Exit SAM  item under the File menu and press [RETURN] .
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Removing a User 
From the Accounts for Users and Groups  screen:

1. Ensure that you have superuser capabilities.

2. Type sam.

3. Highlight Accounts for Users and Groups  and press [RETURN]. This takes you to the 
Accounts for Users and Groups  functional sub-area.

4. Highlight Users  and press [RETURN] . This takes you to the Accounts for Users  screen.

5. Highlight the user you want to remove. You can remove only one user at a time.

6. Choose Remove from the Actions menu and press [RETURN].

7. Highlight the check box, in the Remove a User  dialog box, that describes what you want to do 
with the removed user's files and directories then select the OK button.

8. If you want to continue with the user removal as specified in the Confirmation dialog box, activate the 
Yes button. This will return you to the Accounts for Users screen.

9. If you do not want to continue with the user removal as specified, activate the No button, select the 
correct removal choice and activate the OK button. This will return you to the beginning of this step.

10. If you do not want to continue with the removal at all, activate the No button, and then activate the 
Cancel button in the Remove a User  dialog box. This will return you to the Accounts for 
Users screen.

11. If you want to remove another user, return to step 1 of this procedure.

To return to the Accounts for Users and Groups  functional sub-area, choose Exit  from the 
File menu. To return to the functional area list, highlight [go up]  and press [RETURN] .

To exit the SAM, choose Exit SAM  on the File menu.
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Displaying/Modifying a User's Account Information 
1. Ensure that you have superuser capabilities.

2. Type sam.

3. Highlight Accounts for Users and Groups and press [RETURN].

4. Highlight Users and press [RETURN].

5. Highlight the user account to modify in the object list.

6. Choose Modify…from the Actions menu. This will open the Modify a User dialog box. This dialog 
box lists the information about the selected user.

a. Viewing Only: After you have finished collecting information about a user, activate the Cancel 
button.

b. Modifying: Fill in the new information in the Modify a User dialog box. You can modify the 
following information:

• Login name (user_name)

• Password

• User identification number (user_ID)

• Primary group identification number (group_ID)

• Comment

• Login directory

• Start up program

c. When you have completed your modifications, activate the OK button. A Note dialog box will 
confirm the modification.

d. Activate the OK button in the Note dialog box. This will return you to the Accounts for Users and 
Groups screen.

To return to the Accounts for Users and Groups functional sub-area, choose Exit from the File menu. To 
return to the functional area list, highlight go up and press [RETURN].

To exit the SAM, choose the Exit SAM  item under the File menu.



Chapter 6 6-5

Adding and Modifying Users and Groups
Adding a Group

Adding a Group 
1. Ensure that you have superuser capabilities.

2. Type sam.

3. Highlight Accounts for Users and Groups-> and press [RETURN].

4. Highlight Groups and press Return.

5. Choose Add from the Actions menu.

6. Fill in the new group name and optionally highlight the users to be members of the newly created 
group.

If you have more groups to add, activate the Apply button. You will be returned to the Add a New Group 
screen to add an additional group.

If this is the last group you are adding, activate the OK button. This will return you to the Groups 
sub-area of the Accounts for Users and Groups screen.

To return to the Accounts for Users and Groups functional sub-area, choose Exit from the File menu.

To return to the functional area list, highlight go up and press [RETURN].

To exit the SAM, choose the Exit SAM  item under the File menu.



6-6 Chapter 6  

Adding and Modifying Users and Groups
Removing a Group

Removing a Group 
1. Ensure that you have superuser capabilities.

2. Type sam.

3. Highlight the Accounts for Users and Groups  and press [RETURN].

4. Highlight Groups  and press [RETURN] .

5. Highlight the name of the group you want to remove.

6. Choose Remove from the Actions  menu.

7. Choose group file reassignment. (You can assign the group's files to another group, otherwise, the 
SAM will reassign the group's files to the primary group of each of the file's owners.)

8. Activate the OK button. the SAM then displays a dialog box confirming the removal of the group and 
the reassignment of files.

9. Activate the OK button. You will be returned to the Groups  sub-area screen of Accounts for 
Users and Groups .

10.To remove additional groups, continue at step 5 above.

You have now completed removing a group or groups.

To return to the Accounts for Users and Groups  functional sub-area, choose Exit from the 
File menu.

To return to the functional area list, highlight go up and press [RETURN] .

To exit the SAM, choose the Exit SAM  item under the File menu.

NOTE Chapter 7 - Configuring Your Network Software describes how to configure your network 
software.
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Configuring Your Network Software 
Configuring your network consists of entering information about the following network software:

• LAN (Local Area Network).

• IS (Internet Services) (formerly ARPA).

• NFS (Network File System).

If you have purchased the optional X.25 networking product, see the two included X.25 manuals for 
information on configuring this product.

Network Configuration 
You enter the configuration information using the System Administration Manager (SAM), a tool that 
automates the configuration process. You must log in as a super-user (root) to use the SAM.

For additional information on these networking products, order the following manuals:

• Installing and Administering LAN/9000

• Installing and Administering Internet Services

• Installing and Administering NFS Services

Executing man manuals will retrieve the HP-UX on-line reference page listing manual names and part 
numbers.

The following is an overview of the steps required to configure your network software:

• Complete the configuration worksheets shown on the following pages.This step is very important. 
Don't continue until you've gathered all the information you need to be successful in configuring your 
network. If there is a network administrator in your company, check with that person for help in 
completing the worksheets.

NOTE Some responses in the worksheet require entering the appropriate data/values while others 
require checking a Yes or No checkbox.

• Configure your computer's LAN card and "subnetwork" information (Configuring LAN/9000 
software).
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• Configure your computer to communicate with other computers (Configuring ARPA Services 
software). The computer you use (called the "local host" computer) can send information to, and 
receive information from, other computers (called "remote host" computers). Set this up by 
configuring system-to-system connectivity.

• Configure your computer to transfer files between computers (Configuring NFS software). This step 
may not apply to you; check with your network administrator. If necessary for your needs, you may 
configure your local computer to access files on remote computers as if they were on your local 
computer, and give remote computers access to your local files.

• Reboot the operating system. Rebooting the operating system will put into effect all the configuration 
changes you have made.

Table 7-1 Local, Remote, and Gateway Worksheet

Category of 
Information

SAM Window To 
Use

Type of Information
Your 

Configuration 
Information

Local Host Computer Note: This 
information is 
requested when 
starting the computer

Internet (IP) Address

Host name

Configure LAN Card Configure subnetwork mask [] yes
[] no

Subnet Mask

Remote Host 
Computer

Add Internet 
Connectivity

Remote Internet (IP) 
Address

Remote System Name (Host 
name)

Gateway Computer Modify Default 
Gateway

Default Gateway Internet 
(IP) Address

Default Gateway Name 
(Host name)
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Table 7-2  NFS Client and Server Worksheet

Category of 
Information

Category of 
Information

Type of Information
Your Configuration 

Information

NFS Client: Mount 
Remote File Systems

Add Remote File 
System

Local Directory 
Name

Remote Directory 
Name

Remote Server Name

When To Mount [] now 
[] on boot

Access Permissions [] read only
[] read/write

Allow Set UID 
execution

[] yes
[] no

NFS Server: Export 
Local File Systems

Add Exported File 
System

Local Directory 
Name

Choose option for the 
unknown userid

[] Use uid 'nobody' [] 
Disable unknown 
UID access
[]Specify uid for 
unknown user

Allow Asynchronous 
Writes

[] Yes 
[] No

Specify Access All Systems:
[] Read-only
[] Read-Write
[] Read-Mostly 

Selected Systems: [] 
Read-only
[] Read-Write
[] Read-Mostly

Specify Root User 
Access

Remote System 
Name
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Using the System Administration Manager 

Use the SAM to configure your network software. Start the SAM by typing sam (in lower case) at the 
superuser prompt. Pressing [Ctrl-K]  gives you help information about the SAM.

Choosing items from the Help menu gives you information about:

• The current functional area

• Keyboard navigation within the SAM

• Using the SAM help system

Displaying the release of the SAM you are currently running

Activating the Help button, when available, gives you information about the attributes and tasks you can 
perform from the currently displayed screen.

Pressing the [F1] key gives you context-sensitive help for the field at the location of the cursor.

Exit the SAM by activating the Exit SAM  button from the SAM main screen.

If you have performed tasks that require the generation of a new kernel, the SAM will prompt you to 
regenerate the kernel and reboot the system.

Identifying LAN Card and Subnetwork Information (Configuring 
LAN/9000)

The first step in configuring your network is to define LAN card and subnetwork information.

NOTE Configuration Guidelines

1. Some system configurations can compete for I/O bus usage with the built-in 802.3 
LAN interface on the standard multifunction I/O (CoreI/O). The result is a slow down 
in LAN performance due to an increase in CRC errors (LAN retries). An add-in 802.3 
LAN card should be used as the primary LAN interface when using four or more 
Kx70 or Kx80 processors with less than 1.5GB of memory, or when using the 
VISUALIZE 2-D graphics card in the optional H-HSC I/O slot on the multifunction 
I/O.

2. If a 100BT I/O card (NIO or GSC) is installed, DO NOT USE LASI LAN.

3. A minimum of 1.5GB of main memory must be configured so that there are eight 
banks or greater in at least one memory interleave group. Memory module sizes 
should be limited to 32MB (64MB pair) of Double In-line Memory Modules 
(DIMMs) or larger. For best performance, it is recommended that memory be 
configured over two memory carriers.

The LAN hardware card is already installed on your computer as LAN 0. The LAN/9000 software has 
also been pre-installed. LAN/9000 provides network connections for the ARPA and NFS network 
services you will configure later in this chapter.

If you are connecting this LAN card to a subnetwork, you need to enter the "subnet mask," an address 
that allows you to communicate with computers on other LANs.
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Check with your network administrator to see if you need to perform this task. If not, skip to the next 
section, Communicating with Other Computers.

To configure your subnetwork mask, do the following:

1. Go to the SAM main window

2. Type: sam

3. Go to the "Networking and Communications" screen. Press the down arrow key to highlight 
Networking and Communications Press [RETURN].

4. Go to the Network Interface Cards screen. Press down arrow key to highlight Network Interface 
Cards Press [RETURN].

5. Go to the Configure LAN Card screen. Press down arrow key to move the cursor to your LAN card, 
lan0, in the object list. Press [RETURN] to highlight your LAN card. Press [Tab]  to move up to the 
menu bar, and then press the right arrow key to move the highlight to the Actions menu. Press 
[RETURN] to pull down the Actions menu, and press the down arrow key to highlight Configure. Press 
[RETURN] the SAM displays the Configure LAN Card screen.

6. Fill in the fields in the Configure LAN Card using the information in the Local Host Computer 
section of the configuration worksheet. Use the SAM help system for information about filling in the 
fields.

7. Go back to the object list Press [Tab]  to highlight the OK button Press [RETURN] to perform the task and 
return to the object list. The SAM updates the list to include the subnet mask you configured for your 
LAN card. Make sure the status of your LAN card is Enabled.

8. When you are finished, go back to the Networking and Communications  screen.

Press [Tab]  to highlight the File menu; press [RETURN] to pull down the File menu.

Press the down arrow key to highlight Exit and press [RETURN] to return to the Networking and 
Communications screen.

By performing the steps above, you have identified which subnetwork your LAN card (lan0) is 
connected to. After completing this task, continue to Communicating with Other Computers.
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Communicating with Other Computers (Configuring Internet Services) 

The next step in configuring your network is to tell your computer about other computers you wish to 
communicate with. Internet Services lets your computer communicate on a LAN with other computers. 
When you configure Internet Services, you identify the "remote" computers with which your computer 
will communicate.

To add information about other computers, including the default gateway, do the following:

1. At the Networking and Communications  menu, highlight Internet Addresses  and 
press [RETURN]. The SAM displays an object list with the IP addresses and remote system names that 
are already configured.

2. Choose Add from the Actions menu The SAM displays the Add Internet Connectivity  
screen.

3. Fill in the fields using the information in the Remote Host Computer section of the configuration 
worksheet. Use the SAM help system for information about filling in the fields.

4. Activate the OK button to perform the task and return to Internet Addresses  screen. The SAM 
displays the gateway name and internet (IP) address you specified as the default gateway.

5. Choose Modify default gateway  from the Actions  menu. The SAM displays the Modify 
Default Gateway  screen.

6. Fill in the fields using the information in the Gateway Computer  section of the configuration 
worksheet. Use the SAM help system for information about filling in the fields.

7. Activate the OK button to perform the task and return to the object list. The SAM updates the list to 
include the remote computer system you configured.

8. Repeat steps 3 through 7 to add information about more computers.

9. Choose Exit  from the File menu to return to the Networking and Communications  screen, 
and then activate the (go up) entry to return to the SAM main screen.

By performing the steps above, you have identified another computer or computers you want to 
communicate with. This might include a corporate computer you wish to share data with, or other 
computers in your building. You have also set up the default gateway (if required). A gateway connects 
two or more networks together and routes information among the networks to which it is connected.

NOTE The next step in configuring your network software is to configure NFS; however, you 
may not need to perform this step. Check with your network administrator. If you don't 
wish to configure NFS, skip to the section, Rebooting Your Computer. Once you've 
completed that section, you're done configuring your network.

Transferring Files Between Computers (Configuring NFS) 

NOTE Configuring NFS will allow you to access file systems on remote computers and remote 
computers to access file systems on your local computer. Check with your network 
administrator to see if you need this capability. If not, skip this section and continue with 
the section on Rebooting Your Computer. Once you've completed that section, you're 
done configuring your network.
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• Allowing this computer access to remote file systems via NFS (mounting a remote file system).

• Allowing remote computers access to local file systems via NFS (exporting a local file system).

• Viewing or modifying remote procedure call (RPC) services' security.

This section will help you configure your computer to be able to transfer files between your computer 
and other computers. This is called "creating an NFS client and server."

When you access files on a remote computer, your local computer is called the "client" and the remote 
computer, which supplies the files, is called the "server." When a remote computer accesses files on your 
local computer, the remote computer is the "client" and the local computer is the "server." In this way, 
your local computer can be defined as both a client and a server at the same time.

By identifying your local computer as a client, you are telling the operating system that you wish to have 
access to files on remote computers. By identifying your local computer as a server, you are telling the 
operating system that you wish to make files on your computer available to remote computers.

NOTE NFS is not supported over the X.25 link product. 

Allowing Your Computer Access to Remote File Systems via NFS 
(Mounting a Remote File System)

1. Go to the Networking and Communication screen

a. At the SAM main screen, highlight Networking and Communications.

b. Press: [RETURN].

2. Go to the Networked File Systems  screen

a. Highlight Networked File Systems

b. Press: [RETURN]

3. Go to the Mounted Remote File Systems screen

a. Highlight Remote File Systems Mounted

b. Press: [RETURN]

4. Go to the Add Remote File System  screen

a. Press: [Tab]  to get to the menu bar

b. Press: the right arrow key to get to the Action menu

c. Press: [RETURN] to pull down the Action  menu

d. Press: down arrow key to highlight Add Remote File System

e. Press: [RETURN] to show the sub-menu

f. Press the arrow key to highlight Using NFS

g. Press: [RETURN] to get to the Add Remote File System  screen
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5. Fill in the fields using the information in the NFS Client: Mount Remote File Systems  
section of the configuration worksheet. Use the SAM help system for information about filling in the 
fields.

6. Activate the OK button to perform the task and return to the object list. The SAM updates the list to 
include the remote systems and directories you configured.

7. Repeat steps 4 through 6, for each system that you need to access.

8. If the SAM displays the NFS Client status as Disabled, choose Enable NFS Client  from the 
Actions  menu.

9. Go to the next section, Allowing Remote Computers Access to Your File System 
via NFS  (Exporting a Local File System).

By performing these steps, you have identified which file systems you wish to access on remote 
computers.

Allowing Remote Computers Access to Your File System via NFS 
(Exporting a Local File System)

1. Go to the Networked File Systems screen

a. From the SAM main screen go to Networking and Communications  screen

b. From Networking and Communications  screen go to Networked File Systems  
screen

2. Choose Exported Local File Systems from the object list. The SAM displays the 
Exported Local File Systems screen.

3. Choose Add Exported File System  from the Actions  menu. The SAM displays the Add 
Exported File System  screen.

4. Fill in the fields using the information in the NFS Server: Export Local File Systems 
section of the configuration worksheet. Use the SAM help system for information about filling in the 
fields.

5. Activate the OK button to perform the task and return to the Exported Local File Systems  
object list. The SAM updates the list to include the local directory or directories you configured.

6. Repeat steps 3 through 5 for each remote file system that you wish to access.

7. If the SAM displays the NFS Server status as Disabled, choose Enable NFS Server  from the 
Actions menu.

8. Choose Exit  from the List menu. The SAM returns you to the Networked File Systems  
screen.

By performing these steps, you have identified which local file systems may be accessed by remote 
computers.

This completes the NFS configuration portion. To implement the changes into the operating system, go 
to the Rebooting Your Computer section.
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Rebooting Your Computer 

CAUTION Before rebooting, be sure no one is logged onto your computer. If you do not reboot the 
operating system when you exit the SAM, NFS Services will not run with the 
configurations you just made.

After you've configured LAN, IS, or NFS, you need to reboot the computer to make those changes 
effective. A message appears to let you know that a kernel regeneration and reboot are necessary. When 
this happens:

1. Finish all your NFS configuration tasks.

2. Activate the Exit SAM  button to exit the SAM.

3. When the kernel regeneration and reboot message appears, choose kernel regeneration.

4. When the kernel regeneration is complete and the reboot message appears, reboot your computer.

After rebooting, you've completed configuring your network.

Chapter 8 - Backing Up the Operating System and Ending Your Work Session describes how to back up 
your operating system.
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Backing Up the Operating System 
You have put a lot of time and effort into installing and customizing your operating system. This work 
can easily be lost by a hardware failure, an operating system crash, or accidental removal or corruption of 
a file. It is critically important that you fully backup all files before the computer is first put on line, and 
that you establish and maintain a periodic backup schedule.

It is essential that you purchase one set of HP-UX operating system tapes per site. You will not be able to 
boot your computer from your backup tape. This backup tape will, however, allow you to reclaim your 
system customization, such as restoring the users you have added. 

Backing up all of your files will take about one and one-half hours.

Backup 
First, load a tape into your tape drive.

You can use the SAM to back up your system. Determine the device file for the device on which to create 
your backup. All configured HP-UX devices have a device file associated with them that tells HP-UX the 
hardware address of the device and the driver to use when communicating with the device. For more 
information about device files and drivers, see the HP-UX System Administration Tasks manual or the 
Configuring HP-UX for Peripherals manual.

Start the SAM by typing sam (in lower case) at the superuser prompt. Pressing [Ctrl-K]  gives you help 
information about the SAM.

Choosing items from the Help menu gives you information about:

• The current functional area.

• Keyboard navigation within the SAM.

• Using the SAM help system.

• Displaying the release of the SAM you are currently running.

Activating the Help button, when available, gives you information about the attributes and tasks that you 
can perform from the currently displayed screen.

Pressing the [F1]  key gives you context-sensitive information for the field at the location of the cursor. If 
you have no [F1] key you can type [Ctrl-F]  to get context-sensitive information.

Exit the SAM by activating the Exit SAM  button from the SAM main screen.
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NOTE If you have performed tasks that require the generation of a new kernel, the SAM will 
prompt you to regenerate the kernel and reboot the system.

To back up your system: 

1. Type sam (all lowercase)

2. Highlight Backup and Recovery and press [RETURN] .

3. Highlight Interactive Backup and Recovery and press [RETURN].

4. Highlight the backup device from the object list.

5. Choose Backup Files Interactively  from the Actions  menu.

6. Highlight Select Backup Scope  and press [RETURN] .

7. Highlight Specified Files  and press [RETURN] .

8. Highlight Local File Systems Only (no NFS)  and press [RETURN].

9. Activate the OK button.

NOTE If you are using an Autochanger device you will need to select Specify Tape Drive 
Options…and choose appropriate options. See the HP-UX System Administration Tasks 
manual for instructions.

Activate the OK button to begin the backup process.

Confirmation messages will appear. Activate the OK button to proceed in each case.

NOTE If you created an index log, the information displayed will appear in the index log.

10.Exit the SAM by selecting Exit from the File menu on the current screen, and then Exit SAM  from 
the File menu on the next screen.

Ending Your Work Session 
When you are finished working on your computer.

CAUTION DO NOT turn your computer off! You computer is a multi-user system and other people 
may be using it. If you turn it off, you will deny them access to the computer, and may 
cause them to lose some of their work.

If you have to turn off your computer, see System Administration Tasks for information on properly 
shutting down your computer.

Ending Your Work Session:

When you are finished working with your computer, perform the following steps to end your work 
session:

1. Exit your application software.
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2. Type exit and press [RETURN] to exit to the login prompt

NOTE If you have several work sessions (shells) opened, you may have to perform step 2 several 
times before you are returned to the login prompt.

This leaves you at the login prompt, and the computer is ready for the next user.

Timer Controlled Power On and Off 
If you have the optional UPS, you may preset times for your computer to automatically turn off and back 
on.

Commands are sent to the UPS telling it when to turn off and when to start up again. These same 
commands also gracefully shut down the operating system. This process can be automated using the cron 
command.

The command power_onoff(1M) is used to perform this function. See HP-UX Reference, or the 
manpages, for information on using these commands.
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Site Preparation Requirements
This appendix details site preparation requirements for installing your computer. Your computer is 
designed to operate under environmental conditions suitable for an office environment. The operating 
specifications listed in the following tables are within the normal range of an office environment.

If you are unsure of the electrical and environmental conditions in the area that the computer is to be 
installed, here are some suggestions for verification:

Contact the building maintenance department to verify the specifications.

Hire a licensed electrical contractor familiar with the local electrical codes to verify the specifications.

Contact your local HP sales representative to hire an HP field engineer to verify the specifications.

NOTE Make sure that the electrical installation complies with all local and national electrical 
codes and regulations.

UPS Issues 

This power requirement will also affect the use of UPS systems and rackmount configurations. The 1.8 
kVA, 3kVA, and 5.5kVA Power Trust UPSs are the only UPS systems supported on HP 9000 
K250/K260/K450/K450 computers. 1.3 kVA and 1.6kVA Power Trust UPSs do not have a 20 amp 
receptacle and cannot provide sufficient current.

Special Power Requirements

The following K Class computers require a 20 amp services, as compared to 15 amp service for earlier K 
Class family products:

Ensure that the appropriate power is available for these systems, either through dedicated circuits for 
stand-alone units, or through the 1.8 kVA and 3.0kVA Power Trust UPSs in rack-mounted systems.

K250 K450 K370 K380

K260 K460 K570 K580
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Verifying Environmental and Electrical Specifications 

Review the environmental and electrical requirements in this section of the manual prior to applying 
power.

The HP 9000 operates from a wide range of voltages and on commonly available frequencies of 50 and 
60 Hz. Check your local power source to determine if you have sufficient current available for your 
particular configuration. The systems automatically adjust to alternating current of 100, 120-127 or 
200-240 volts.

Table A-1 Environmental Specifications — Kx00/Kx10/Kx20 Systems

Description Specification

Operating Temperature 5 to 40°C (41 to 104°F)

Non-operating 
Temperature

-40 to 65°C (-40 to 149°F) (with no internal tape media device)

-40 to 45°C (-40 to 113°F) (with internal tape media device)

Temperature Rate of 
Change

20°C (36°F)/hr. (with no internal tape media device)

10°C (18°F)/hr. (with internal tape media device)

Over Temperature Warning 35°C (95°F)

Over Temperature Second 
Warning

40°C (104°F)

Over Temperature 
Shutdown

43°C (109°F)

Operating Humidity 15% to 80% RH non-condensing, max wet bulb (at 26°C (79°F) with 
internal tape media device)

Non-operating Humidity 5% to 80% RH non-condensing (at 65°C (149°F)) (rate of change, 30% 
RH/hr)

Operating Altitude 0 to 3000 meters (0 to approx. 10,000 ft)

Non-operating Altitude 0 to 4500 meters (0 to approx. 15,000 ft)
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Heat Dissipation 4263 BTU/hr. (maximum load)

Acoustics Data measured in 24°C (75.2°F) ambient temperature. Acoustic 
performance and fan speeds vary with temperature between 18 °C 
(64.4°F) and 40°C (104°F). NPT = No Prominent Tone.

Deskside (LwA):

Tape Backup Mode = %<5.8 Bels

Normal Operating Mode = %<5.7 Bels

Operator Position:

Tape Backup Mode = %<46 dB-LpA, NPT

Normal Operating Mode = %<45 dB-LpA, NPT

Racked System (LwA):

Tape Backup Mode = %<6.5 Bels

Normal Operating Mode = %<6.5 Bels

Operator Position:

Tape Backup Mode = %<52 dB-LpA, NPT

Normal Operating Mode = %<52 dB-LpA, NPT

Safety UL Listed to UL1950

CSA Certified to CSA C22-2 No. 950

TUV GS Mark, compliant with IEC 950, EN60950, and EN41003

Description Specification
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Table A-2 Environmental Specifications — Kx50/Kx60/Kx70/Kx80 Systems

Description Specification

Operating Temperature 5 to 40°C (41 to 104°F) for Kx70
5 to 35° C (41 to 95°F) for Kx80

Non-operating Temperature -40 to 65°C (-40 to 149°F) (with no internal tape media device)

-40 to 45°C (-40 to 113°F) (with internal tape media device)

Temperature Rate of Change 20°C (36°F)/hr. (with no internal tape media device)

10°C (18°F)/hr. (with internal tape media device)

Over Temperature Warning 35°C (95°F)

Over Temperature Second 
Warning

40°C (104°F)

Over Temperature Shutdown 43°C (109°F)

Operating Humidity 15% to 80% RH non-condensing, max wet bulb (at 26°C (79°F) with 
internal tape media device)

Non-operating Humidity 5% to 80% RH non-condensing (at 65°C (149°F)) (rate of change, 30% 
RH/hr)

Operating Altitude 0 to 3000 meters (0 to approx. 10,000 ft)

Non-operating Altitude 0 to 4500 meters (0 to approx. 15,000 ft)
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Heat Dissipation 5846 BTU/hr. (maximum load)

Acoustics Data measured in 24°C (75.2°F) ambient temperature. Acoustic 
performance and fan speeds vary with temperature between 18 °C 
(64.4°F) and 40°C (104°F). NPT = No Prominent Tone.

Deskside (LwA):

Tape Backup Mode = %<5.8 Bels

Normal Operating Mode = %<5.7 Bels

Operator Position:

Tape Backup Mode = %<46 dB-LpA, NPT

Normal Operating Mode = %<45 dB-LpA, NPT

Racked System (LwA):

Tape Backup Mode = %<6.5 Bels

Normal Operating Mode = %<6.5 Bels

Operator Position:

Tape Backup Mode = %<52 dB-LpA, NPT

Normal Operating Mode = %<52 dB-LpA, NPT

Safety UL Listed to UL1950

CSA Certified to CSA C22-2 No. 950

TUV GS Mark, compliant with IEC 950, EN60950, and EN41003

Description Specification
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Table A-3 Electrical Specifications — Kx00/Kx10/Kx20

Description Specification

AC Input Voltage Range 100, 120-127, or 200-240 VAC, 10%

AC Input Line Frequencya

a. The power supply auto-ranges to the AC voltage and frequency. It does not have to be 
reconfigured to operate over its rated operating ranges.

50 - 60 Hz

AC Input Current 12.5 A (max load at 100 VAC)

10.5 A (max load at 120 VAC)

6.0 A (max load at 200 - 240 VAC)

AC Inrush Current 16 A peak, one cycle

AC Input Power 1250 watts maximum, 450 watts typicalb

b. The typical AC input power rating is based on a configuration of 3 CPUs, 3 internal 
disks, 1 memory controller, 288 MBytes of memory, 2 HP-HSC expansion cards, 1 
HP-PB FDDI and 1 F/W SCSI card.

Power Supply Output 925 watts DC continuous maximum

Holdup without system 
reset

20ms at 50/60Hz (1 cycle, or 500ms)

Battery Backup Time 15 minutes (with optional external PowerTrust UPS, without optional UPS 
there is no battery backup)

Branch Circuit Rating minimum 15A, individual branch circuit rating
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Table A-4 Electrical Specifications — Kx50/Kx60/Kx70

CAUTION Failure to ensure that the computer site complies with the listed specifications could cause 
possible data loss, equipment damage, and void the HP warranty for the computer.

Description Specification

AC Input Voltage Range 100, 120-127, or 200-240 VAC, 10%

AC Input Line Frequencya

a. The power supply auto-ranges to the AC voltage and frequency. It does not have to be 
reconfigured to operate over its rated operating ranges.

50 - 60 Hz

AC Input Current 19.5 A (max load at 100 VAC)

16.0 A (max load at 120 VAC)

10.0 A (max load at 200 - 240 VAC)

AC Inrush Current 48.65 A @ 140VAC/60Hz 
58.26 A @ 264VAC/50Hz

AC Input Power 2400 watts maximum,

Power Supply Output 1200 watts DC continuous maximum. 550 watts typicalb

b. The typical AC input power rating is based on a configuration of 3 CPUs, 3 internal 
disks, 1 memory controller, 288 MBytes of memory, 2 HP-HSC expansion cards, 1 
HP-PB FDDI and 1 F/W SCSI card.

Holdup without system 
reset

20ms at 50/60Hz (1 cycle, or 500ms)

Battery Backup Time 15 minutes (with optional external PowerTrust UPS, without optional UPS 
there is no battery backup)

Branch Circuit Rating minimum 20A, individual branch circuit rating
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DO

• Provide sufficient electrical outlets for the Core System plus any additional external devices. If you 
use the optional UPS, you will need only one (1) outlet for the Core System UPS external power 
connector. External peripherals such as printers are typically not connected to the UPS; they require a 
separate outlet.

• Remote cables should be routed to avoid obstructions for personnel.

• Allow at least twelve (12) inches of ventilation space in front of and behind the computer for the front 
and rear mounted cooling fans.

• Provide a desk or table next to the computer for the console and keyboard. The distance from the 
console to the computer is determined by the length of the connecting cable.

• Provide a storage cabinet for computer supplies (tapes, disks, printer supplies, etc.)

• Provide a dedicated telephone outlet close to the computer (for a data modem).

• Be sure the computer site is well ventilated and adequate lighting is available.

• Plan peripheral installation in accordance with cable length.

DON'T

• Do not install the computer next to open windows or doorways where heavy traffic is likely.

• Do not plug the computer or computer peripherals into outlets that are controlled by a switch. If the 
outlets that are controlled by a switch, cover or protect the switch from accidental de-activation.

• Do not plug non-office type equipment into the same outlet with the computer. This would include 
things such as: coffee pots, heaters, fans, radios, or TVs.

• Do not use extension cords.

• Do not use SPU as a plant stand (or coffee table).
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Hardware Installation Review 
This appendix is not an exact duplicate of your Installation Guide but it does provide a second source for 
the same information. If the installation guide is not handy when you need to review some part of the 
installation procedure, use this appendix.

In this appendix the steps are not re-explained with each illustration. If you want to do your installation 
or reinstallation using this appendix, follow the steps starting on the next page. For each step, refer the 
illustration page with the same heading.

The Core I/O board shown in the illustrations do not reflect the audio and headset jacks present in the 
K250/K260/K450/K460 Core I/O board. For a review of those features see Figure 2-20. Also, refer to see 
"Special Power Requirements" on page 3 of Appendix A.

Introduction 

This installation guide illustrates the procedures for installing all HP9000 K-class servers. The contents 
of this guide include:

1. Overview of System Power/Data Cabling - A reference figure showing the basic power and data 
connections for the core system (System Processing Unit and Console).

2. System Installation Steps - a brief description of each step of the installation procedure.

3. Installation Illustrations - A series of figures showing each step in the installation process.
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Overview of System Power and Data Cabling 

The figure below shows an overview of the power and data cabling for the SPU, console, and the 
optional UPS, and is intended for reference only. To proceed with actual installation of the system, start 
at the page titled "Standard Console, Keyboard, and Optional UPS."
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System Installation Steps 

STEP 1: Standard Console, Keyboard, and Optional Uninterruptible Power System (UPS)

If you want to install a graphics console instead of the standard console, skip to STEP 1A.

1. Connect the standard console data cable to the "Console" port on the Core I/O board of the SPU.

2. Plug the standard console power cable into a UPS power receptacle.

3. Connect the keyboard cable to the keyboard connector on the console.

4. Connect the UPS data cable between the "UPS" connector on the SPU and the appropriate data 
connector on the UPS.

NOTE Do not plug the UPS into a power receptacle at this time.

Skip to STEP 2.

Standard Console, Keyboard, and Optional UPS
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STEP 1A: Optional Graphics Console: A2094A Graphics Display with Keyboard, Mouse, 
and Optional UPS

1. Connect the graphics console data cable to the "OPTIONAL I/O" port on the SPU Core I/O card.

2. Plug the graphics console power cable in a UPS power receptacle.

3. Connect the keyboard cable to the keyboard connector on the Core I/O card of the SPU.

4. Connect the mouse cable to the connector labeled "MOUSE" on the SPU core I/O card.

5. Connect the UPS data cable between the "UPS" connector on the SPU and the appropriate data 
connector on the UPS.

Optional Graphics Console: A2094A Graphics Display with Keyboard, Mouse and 
Optional UPS
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STEP 2: Local Area Network (LAN), Fast/Wide Differential SCSI, and Parallel Device 
Cabling

1. Connect the LAN to either the "10BASE-T" or the "AUI" connector on the Core I/O card.

2. Connect the Fast/Wide cable or terminator to the "F/W DIFF. SCSI" connector on the Core I/O card.

3. Connect an optional parallel device (such as a printer) to the connector labeled "PARALLEL" on the 
Core I/O card.

Local Area Network (LAN), Fast/Wide Differential SCSI, and Parallel Device Cabling

NOTE Configuration Guidelines

1. Some system configurations can compete for I/O bus usage with the built-in 802.3 
LAN interface on the standard multifunction I/O (CoreI/O). The result is a slow down 
in LAN performance due to an increase in CRC errors (LAN retries). An add-in 802.3 
LAN card should be used as the primary LAN interface when using four or more 
Kx70 or Kx80 processors with less than 1.5GB of memory, or when using the 
VISUALIZE 2-D graphics card in the optional H-HSC I/O slot on the multifunction 
I/O.

2. If a 100BT I/O card (NIO or GSC) is installed, DO NOT USE LASI LAN.

3. A minimum of 1.5GB of main memory must be configured so that there are eight 
banks or greater in at least one memory interleave group. Memory module sizes 
should be limited to 32MB (64MB pair) of Double In-line Memory Modules 
(DIMMs) or larger. For best performance, it is recommended that memory be 
configured over two memory carriers.
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STEP 3: Internal or External Modem, and MDP 

1. Connect the LAM (HP A2991-xxxxx Line Access Module) to the "INTERNAL MODEM" connector 
on the Core I/O card. If using an internal modem, do not connect an external modem, skip to Step c. 
below.

2. If not using the internal modem, connect the external modem to the "EXTERNAL MODEM" 
connector on the core I/O card.

3. Connect the Modem Distribution Panel (MDP) to the "MDP" connector on the Core I/O card.

Internal or External Modem and MDP 



Appendix B B-7

Hardware Installation
Hardware Installation Review

STEP 4: Power Connections 

1. If you are using an Uninterruptible Power System (UPS), plug the SPU power cable into the power 
receptacle at the upper-left corner of the UPS, then plug the UPS power cable into wall power.

2. If not using the UPS, connect the SPU power cable directly to wall power.

Power Connections 
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STEP 5: Stabilizer Block 

Roll the SPU cabinet onto the stabilizer block in the desired location to prevent the SPU from being 
inadvertently moved around. 

Stabilizer Block
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STEP 6: Power On 

Refer to Chapter 2, Exploring Your Hardware, for hardware familiarization and instructions about 
turning on your computer.

Power On 
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Summary of System Connections 
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Computer Addressing for Model K100 
Table C-1 K100 Internal Address Paths - Core I/O

Location/Description Device Type
Address Path 

(Dec)a

a. (da)=(device address)

FW DIFF SCSI connector FW DIFF SCSI devices 8/0.(da)

Console connector (MDP port 0) HP700/96 system console 8/4/0.0

UPS connector (MDP port 1) 1300VA PowerTrust (UPS) 8/4/0.1

MDP connector: (ports 2, 3, 4, 5, 6) A Modem Distribution Panel (MDP) is 
connected to the Core I/Oconnector. 
Supported devices are then connected to 
the MDP.

8/4/0.2
8/4/0.3
8/4/0.4
8/4/0.5
8/4/0.6

Internal or external modem connector 
(MDP port 7)

HP LAM for Internal modem or an 
external modem

8/4/0.7

Optional I/O (HSC) connector Graphics console 8/8.0

Parallel connector Supported parallel device 8/12/0

10 base or AUI connector Appropriate LAN cable 8/12/6

Keyboard connector graphics option keyboard 8/12/7

Mouse connector graphics option mouse 8/12/8
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Table C-2  K100 Internal Address Paths - Internal Peripherals

Table C-3 K100 Internal Address Paths - HP-PB 0

Location/Description Device Type
Address Path 

(Dec)

Slot A SE SCSI CD-ROM 8/12/5.2

Slot B SE SCSI DDS Drive 8/12/5.0

Slot C (boot disk) FW SCSI disk drive 8/0.6

Slot D FW SCSI disk drive 8/0.5

Slot E FW SCSI disk drive 8/0.4

Slot F FW SCSI disk drive 8/0.3

Location/Description Device Type Address Path (Dec)

Slot 1 HP-PB I/O card 8/4/4.(da)

Slot 2 HP-PB I/O card 8/4/8.(da)

Slot 3 HP-PB I/O card 8/4/12.(da)

Slot 4 HP-PB I/O card 8/4/16.(da)
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Computer Addressing for Model K2x0/K4x0 
Table C-4 K2x0/K4x0 Internal Address Paths - Core I/O

Table C-5 K2x0/K4x0 Internal Address Paths - Internal Peripherals

Location/Description Device Type
Address Path 

(Dec)a

a. (da)=(device address)

FW DIFF SCSI connector FW DIFF SCSI devices 10/0.(da)

Console connector (MDP port 0) HP700/96 system console 10/4/0.0

UPS connector (MDP port 1) 1300VA PowerTrust (UPS) 10/4/0.1

MDP connector: (ports 2, 3, 4, 5, 6) A Modem Distribution Panel (MDP) is 
connected to the Core I/Oconnector. 
Supported devices are then connected to 
the MDP.

10/4/0.2 
10/4/0.3 
10/4/0.4 
10/4/0.5 
10/4/0.6

Internal or external modem connector 
(MDP port 7)

HP LAM for Internal modem or an 
external modem

10/4/0.7

Optional I/O (HSC) connector Graphics console 10/8

Parallel connector Supported parallel device 10/12/0

10 base or AUI connector Appropriate LAN cable 10/12/6

Keyboard connector graphics option keyboard 10/12/7

Mouse connector graphics option mouse 10/12/8

Location/Description Device Type
Address Path 

(Dec)a

a. (da)=(device address)

Slot A SE SCSI CD-ROM 10/12/5.2

Slot B SE SCSI DDS Drive 10/12/5.0

Slot C (boot disk) FW SCSI disk drive 10/0.6

Slot D FW SCSI disk drive 10/0.5

Slot E FW SCSI disk drive 10/0.4

Slot F FW SCSI disk drive 10/0.3



C-4 Appendix C  

Computer Addressing
Computer Addressing for Model K2x0/K4x0

Table C-6 K2x0/K4x0 Internal Address Paths - HP-PB

Table C-7 K4x0 Internal Address Paths - HSC I/O Expansion

Location/Description Device Type
Address Path 

(Dec)a

a. (da)=(device address)

HP-PB 0 Slot 1 HP-PB I/O card 10/4/4.(da)

Slot 2 HP-PB I/O card 10/4/8.(da)

Slot 3 HP-PB I/O card 10/4/12.(da)

Slot 4 HP-PB I/O card 10/4/16.(da)

HP-PB 1

Slot 1

HP-PB I/O card 10/16/4.(da)

Slot 2 HP-PB I/O card 10/16/8.(da)

Slot 3 HP-PB I/O card 10/16/12.(da)

Slot 4 10/16/16.(da) HP-PB I/O card

Location/Description Device Type
Address Path 

(Dec)a

a. (da)=(device address)

Slot 0 HSC I/O card 8/0.(da)

Slot 1 HSC I/O card 8/4.(da)

Slot 2 HSC I/O card 8/8.(da)

Slot 3 HSC I/O card 8/12.(da)
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Computer Addressing for Model K3x0/K5x0 
Table C-8 K3x0/K5x0 Internal Address Paths - Core I/O

Table C-9 K3x0/K5x0 Internal Address Paths - Internal Peripherals

Location/Description Device Type
Address Path 

(Dec)a

a. (da)=(device address)

FW DIFF SCSI connector FW DIFF SCSI devices 10/0

Console connector (MDP port 0) HP700/96 system console 10/4/0.0

UPS connector (MDP port 1) 1300VA PowerTrust (UPS) 10/4/0.1

MDP connector:
(ports 2, 3, 4, 5, 6)

A Modem Distribution Panel (MDP) is 
connected to the Core I/Oconnector. 
Supported devices are then connected to 
the MDP.

10/4/0.2
10/4/0.3
10/4/0.4
10/4/0.5
10/4/0.6

Internal or external modem connector 
(MDP port 7)

HP LAM for Internal modem or an 
external modem

10/4/0.7

Optional I/O (HSC) connector Graphics console 10/8

Parallel connector Supported parallel device 10/12/0

10 base or AUI connector Appropriate LAN cable

Keyboard connector graphics option keyboard 10/12/7.0

Mouse connector graphics option mouse 10/12/8.0

Location/Description Device Type
Address Path 

(Dec)a

a. (da)=(device address)

Slot A SE SCSI CD-ROM 10/12/5.2

Slot B SE SCSI DDS Drive 10/12/5.0

Slot C (boot disk) FW SCSI disk drive 10/0.6

Slot D FW SCSI disk drive 10/0.5

Slot E FW SCSI disk drive 10/0.4

Slot F FW SCSI disk drive 10/0.3
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Table C-10 K3x0/K5x0 Internal Address Paths - HP-PB

Table C-11 K5x0 Internal Address Paths - HSC I/O Expansion

Location/Description Device Type
Address Path 

(Dec)a

a. (da)=(device address)

HP-PB 0 Slot 1 HP-PB I/O card 10/4/4

Slot 2 HP-PB I/O card 10/4/8

HP-PB 1 Slot 1 HP-PB I/O card 10/16/4

Slot 2 HP-PB I/O card 10/16/8

Location/Description Device Type
Address Path 

(Dec)a

a. (da)=(device address)

Primary Four Slot HP-HSC Expansion I/O

Slot 0 HSC I/O card 8/0

Slot 1 HSC I/O card 8/4

Slot 2 HSC I/O card 8/8

Slot 3 HSC I/O card 8/12

Secondary Four Slot HP-HSC Expansion I/O

Slot 0 HSC I/O card 12/0

Slot 1 HSC I/O card 12/12

Slot 2 HSC I/O card 14/8

Slot 3 HSC I/O card 14/12
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Appendix D: UPS Error Messages 

This appendix lists the messages that may be displayed by the UPS Monitor daemon (ups_mond) to 
indicate PowerTrust status or error conditions. The UPS Monitor daemon monitors the conditions of all 
PowerTrust units in an HP-UX system, and notifies the system operator via console messages of any 
PowerTrust alarm conditions and of system power failures.

WARNING This appendix is intended for qualified service-trained personnel only. Actions to be 
taken in response to a given error message are intended to be performed only by 
service-trained personnel.

NOTE The term "UPS" (Uninterruptible Power System) is used in all error messages to refer to 
the PowerTrust unit. The term "UPS Monitor" refers to the software utility (ups_mond) 
that monitors PowerTrust operation.
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Normal Operation Messages 
The messages in this section may appear during normal operation.

ups_mond: UPS Monitor daemon starting; using configuration file <filename>

Severity Information. Start-up processing program message.

Meaning UPS Monitor process creation and activation daemon has successfully begun 
execution.

Cause ups_mond has launched the UPS Monitor process successfully, using the data 
contained in the PowerTrust configuration file.

Action None.

ups_mond: UPS <tty special file name> OK: AC Power back on.

Severity Information. A previous critical, error, or warning condition related to AC 
input power has been corrected.

Meaning The PowerTrust device configured as <tty special file name>informed the 
UPS Monitor that its input AC power has returned to normal following a 
power failure. The PowerTrust unit is now supplying normal power, not 
battery reserve power.

Cause Corrective action succeeded, and normal power has been restored.

Action None.

ups_mond: AC Power to all recognized, system critical UPSs OK! System will not shutdown.

Severity Information. A previous critical or warning condition related to AC input 
power has been corrected.

Meaning Following an AC power failure affecting one or more critical PowerTrust units 
on the system, normal AC power has been restored to all critical PowerTrust 
units before either exhaustion of the battery reserve power, or a graceful 
shutdown, occurs. The system has recovered from the power failure.

Cause The system has recovered from an AC power failure that was short enough not 
to exhaust the PowerTrust unit's battery reserve, nor cause a graceful 
shutdown.

Action None.
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Timer Controlled Power On/Off Messages

The following messages relate to the Timer Controlled Power On/Off utility.

ups_mond: Timer Controlled On/Off information invalid; ignored

Severity Error. Request to turn off the system (with a later turn on) is ignored.

Meaning The power_onoff utility sent an invalid turn-on time to ups_mond.

Cause Internal error in power_onoff.

Action Ensure that the requested turn-on date and time are valid, and within range of 
the PowerTrust unit's capability.

ups_mond: mknod error: <error number> for Timed On/Off fifo file /timed_off; continuing 
without

Severity Error.

Meaning Could not create fifo (also known as a "pipe") for communication between 
power_onoff and ups_mond.

Cause File system problem.

Action Refer to mkfifo(3C) for more information on the error.

ups_mond: open error: <error number> for Timed On/Off fifo file /timed_off; continuing without

Severity Error.

Meaning Could not open fifo (also known as a "pipe") for reading request from the 
power_onoff utility.

Cause File system problem.

Action Refer to mkfifo(3C) for more information on the error.

ups_mond: Timer Controlled On value exceeds UPS <tty special file name> maximum. The 
maximum value of <value> will be used for this UPS.

Severity Warning. Turn-on date and time will be earlier than requested.
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Meaning The PowerTrust hardware does not support the requested length of time for 
delay.

Cause The entered Timer Controller On value was outside the range of the 
PowerTrust unit's capability.

Action Ensure that the requested turn-on date and time are within the range of the 
PowerTrust unit's capability.

ups_mond: Power Off request active; performing graceful shutdown.

Severity Warning.

Meaning The PowerTrust unit has begun a graceful shutdown of the system.

Cause An entered Timer Controller date and time setting for powering off the 
PowerTrust unit has been reached, and the PowerTrust unit has begun to 
gracefully shutdown the system.

Action None.

ups_mond: Timer Controlled On value exceeds UPS <tty special file name> maximum. The 
maximum value of <value> will be used for this UPS.
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Exit ups_mond Daemon Messages 
The messages in this section precede the exiting of the ups_mond daemon. The UPS Monitor will not be 
running, thus the PowerTrust unit(s) will not be monitored.

usage: ups_mond [-f configfile] [-s]

Severity Error.

Meaning Incorrect parameter when invoking ups_mond.

Cause An incorrect parameter was used when invoking ups_mond.

Action Correct the parameter according to the syntax shown in the usage message 
above. If ups_mond was invoked from /etc/inittab,edit that file to correct the 
parameter.

ups_mond: cannot exec/etc/ups_mond -f <filename> -e ups_mon child due to <error number>

Severity Error.

Meaning Cannot execute ups_mond's child process.

Cause Specific cause denoted by <error number> in the message.

Action Ensure that ups_mond exists in the /etc directory, and is executable.

ups_mond: permission denied; must be super user

Severity Error.

Meaning Must be super user to execute ups_mond.

Cause An attempt was made to start ups_mond without super user capability.

Action ups_mond is designed to be started from /etc/inittab by init, which is super 
user.

ups_mond: exiting; unable to lock process in memory: <error number>

Severity Error.
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Meaning An attempt to lock failed.

Cause The specific cause is denoted by the <error number> in the message.

Action Refer to plock(2) for more information on the error.

ups_mond: aborted, configfile <filename> open received error: <error number>

Severity Error.

Meaning Could not open the ups_mond configuration file.

Cause The specific cause is denoted by the <error number> in the message.

Action Ensure that the configuration file named in the message exists, and is readable.

ups_mond: aborted, configfile <filename> fseek error: <error number>

Severity Error.

Meaning ups_mond could not "seek" through the configuration file due to the cause 
denoted by the <error number> in the messages.

Cause File system problem.

Action Refer to fseek(3S) for more information on the error.

ups_mond: terminated by signal <decimal value>

Severity Information.

Meaning The signal received by ups_mond caused termination.

Cause The signal denoted by <decimal value> in the message was received. The 
most common cause is a kill of the ups_mond process.

Action None, if done on purpose.

ups_mond: exiting; unable to lock process in memory: <error number>
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shutdown(1M) Messages
The messages in this section may precede an /etc/shutdown(1M) attempt, depending on the particular 
PowerTrust configuration in the system.

ups_mond: aborted, malloc error: <error number>

Severity Information.

Meaning A memory allocation error caused termination.

Cause The memory allocation error denoted by <error number> in the message 
caused the ups_mond process to terminate.

Action Refer to malloc(3C) for more information.

ups_mond: UPS <tty special file name> AC POWER FAILURE - running on UPS battery

Severity Warning. AC power failure. The PowerTrust unit is supplying battery reserve 
power for up to a maximum of 15 minutes, after which critical PowerTrust 
units will cause a graceful shutdown of the system.

Meaning The PowerTrust device configured as <tty special filename> informed the 
UPS Monitor that its AC input power has failed. The PowerTrust unit is now 
supplying reserve power from its internal battery. Depending on the battery's 
state of charge, there are from 0 to 15 minutes of full-load reserve power 
available before the AC output from the PowerTrust unit shuts off.

Cause AC source power failure, detected by a PowerTrust unit.

Action Locate the AC power source for the PowerTrust unit reporting the power 
failure, and try to restore power before the PowerTrust battery becomes 
exhausted. If this is an isolated, brief power transient failure, no action is 
needed; the system will recover automatically when AC power returns to 
normal.

If power is not returned within previously configured time period, your system will automatically 
go to graceful shutdown.

Severity Warning. Critical (not MSG-ONLY) PowerTrust units have lost AC power.

Meaning One or more critical PowerTrust units are supplying reserve power from their 
internal batteries. If power has not been restored (after the delay specified in 
the configuration file), a graceful shutdown of the system will occur.

Cause Loss of AC power to one or more critical PowerTrust units.

Action Restore AC power source for PowerTrust units reporting power failure. 
Otherwise, allow shutdown of system to occur.
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reboot(2) Messages 
The messages in this section may precede a reboot(2), depending on the particular PowerTrust 
configuration in the system.

ups_mond: UPS <tty special file name> battery low

Severity Critical. The system is operating on insufficient reserve power.

Meaning The PowerTrust device configured as <tty special file name> informed the 
UPS Monitor that while it was operating on its internal battery to supply 
reserve power, the battery drained down to a state of low charge.The 
PowerTrust unit has only about two minutes of battery power remaining, after 
which the PowerTrust output power will fail. If the specified PowerTrust unit 
is a critical PowerTrust unit, then the system will reboot.

Cause The PowerTrust unit detected a loss of AC power, and switched over to its 
internal battery reserve power to supply power to the system. The battery then 
drained down to the point at which a "low charge" condition was detected, or 
the battery had already been depleted by a previous AC power failure, and had 
not had enough time to recharge.

Action Locate the AC power loss problem, and restore that power to the system 
before the battery becomes exhausted.

ups_mond: UPS <tty special file name> no output - either switch setting wrong on UPS or bad UPS

Severity Critical. No power output from the PowerTrust device configured as<tty 
special file name>.

Meaning No output voltage from PowerTrust unit. If the specified PowerTrust unit is a 
critical PowerTrust unit, then the system will reboot.

Cause The cause may be one of the following:

The Output switch setting on the PowerTrust unit is incorrect,

The PowerTrust unit has been turned off programmatically.

The PowerTrust unit is faulty.

Action Toggle the Output switch on the suspect PowerTrust unit. If the output voltage 
is not restored by toggling the switch, replace the PowerTrust unit.
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ups_mond: UPS <tty special file name> failed - requires repair

Severity Critical. PowerTrust hardware has failed, and PowerTrust output power has 
been lost. Some system component(s) now without power.

Meaning The PowerTrust device configured as <tty special file name> is faulty.If the 
specified PowerTrust unit is a critical PowerTrust unit, then the system will 
reboot.

Cause The PowerTrust unit is faulty.

Action Replace the faulty PowerTrust unit.

ups_mond: UPS <tty special file name> current overload; UPS turned itself off - either UPS bad or 
too many devices connected

Severity Critical. PowerTrust hardware has failed, and PowerTrust output power has 
been lost. Some system component(s) now without power.

Meaning The PowerTrust device configured as <tty special file name> informed the 
UPS Monitor that it detected an excessive demand for output power from its 
AC power outlet (greater than 100% of allowable output power), and has 
consequently shut off its output.

Cause Improper system installation has put too much load on the PowerTrust unit, or 
a hardware malfunction in the system equipment being powered by the 
PowerTrust unit has increased the power demand to the point of overload. If 
the specified PowerTrust unit is a critical PowerTrust unit, then the system 
will reboot.

Action Correct the improper system hardware installation, or repair the faulty system 
hardware that is overloading the PowerTrust unit.

ups_mond: UPS <tty special file name> ambient temperature too high; UPS turned itself off - 
reduce heat in area

Severity Critical. PowerTrust hardware has failed, and PowerTrust output power has 
been lost. Some system component(s) now without power.

Meaning The PowerTrust device configured as <tty special file name> informed the 
UPS Monitor that it detected an excessive ambient temperature that makes 
further operation of the PowerTrust unit inadvisable, and has consequently 
shut off its output. If the specified PowerTrust unit is a critical PowerTrust 
unit, then the system will reboot.

Cause The computer room became so hot that the operating temperature limit of the 
PowerTrust unit was exceeded.

Action Reduce the temperature in the computer room.
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ups_mond: UPS <tty special file name> output voltage too high; UPS turned itself off - requires 
repair

Severity Critical. PowerTrust hardware has failed, and PowerTrust output power has 
been lost. Some system component(s) now without power.

Meaning The PowerTrust device configured as <tty special file name> informed the 
UPS Monitor that its output voltage is too high, making further operation of 
the PowerTrust unit inadvisable, and has consequently shut off its output. If 
the specified PowerTrust unit is a critical PowerTrust unit, then the system 
will reboot.

Cause The PowerTrust unit is faulty.

Action Replace the faulty PowerTrust unit.

ups_mond: UPS <tty special file name> output voltage too low; UPS turned itself off - requires 
repair

Severity Critical. PowerTrust hardware has failed, and PowerTrust output power has 
been lost. Some system component(s) now without power.

Meaning The PowerTrust device configured as <tty special file name> informed the 
UPS Monitor that its output voltage is too low for correct system operation, 
and has consequently shut off its output. If the specified PowerTrust unit is a 
critical PowerTrust unit, then the system will reboot.

Cause The PowerTrust unit is faulty.

Action Replace the faulty PowerTrust unit.

ups_mond: cannot reboot due to <error number> returned by exec().

Severity Error.

Meaning A reboot system call failed.

Cause The specific cause is denoted by the <error number> in the message.

Action Refer to exec(2) for more information on the error.
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NOTE All of the reboot(2) messages will be followed by:

ups_mond: reboot -halt invoked due to UPS error cited in previous syslog message.

ups_mond: cannot exec shutdown due to <error number> returned by exec().

Severity Error.

Meaning Cannot execute shutdown process.

Cause The specific cause is denoted by the <error number> in the message.

Action Ensure that shutdown exists in the /etc directory, and that it is executable.
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A-B

absolute pathname The full pathname of a file, 
including all the directories leading to it, starting 
with the root directory ("/") and ending with the 
filename itself. See also file, filename, pathname.

access permissions Settings that allow a user or 
group of users to read, write, or execute files. See 
also file access permissions.

active window The window that is receiving 
input from the keyboard at the present time. If 
there is no active window, anything you type is 
lost. Only one window can be active at a time. The 
active window is said to have the "keyboard 
focus."

ANSI The American National Standards Institute, 
a non-profit organization, made up of various 
expert committees, that publishes standards for 
use by national industries. ANSI has adopted the 
IEEE standards for local area networks.

argument The part of a command line that 
identifies the file or directory to be acted on.

attachment unit interface (AUI) A transceiver 
cable that conforms to IEEE 802.3 specifications.

back up v. To make a copy of the file system on a 
tape or disk that can be stored separately from the 
original files. Also called "backing up the system" 
or simply "system backup."

bitmap Generally speaking, an array of data bits 
used for graphic images. Strictly speaking, a 
pixmap of depth one, capable of representing 
2-color images.

boot Short for bootstrap service. A service 
provided by a short program, stored in the 
read-only memory of your workstation, that loads 
the operating system (or any complex program) 

into main memory. Partner workstations provide 
bootstrap service to diskless workstations. See 
also boot ROM.

boot console interface The interactive firmware 
that enables you to interact with the hardware of 
your workstation before the workstation boots the 
operating system. The boot console interface 
allows you to perform special tasks, display 
information, and set certain system parameters.

boot ROM A read-only memory that is 
incorporated into a workstation for the purpose of 
starting the operating system, testing the terminal, 
and producing a standard display.

bootstrap service See boot.

byte A fundamental character-code unit, usually 
consisting of 8 bits.

C-D

CD-ROM Compact Disc Read-Only Memory. 
See also CD-ROM disc, CD-ROM drive.

CD-ROM disc CD-ROM discs are identical to 
the audio compact discs (CDs) used to record 
stereo music, except that they store data. 
CD-ROM discs are 120 mm (4.7 inches) in 
diameter, and use one data surface with a capacity 
of 600 MB. The data surface contains pits and flat 
spots arranged in a continuous spiral track, which 
is read at a constant speed.

CD-ROM drive A random-access, read-only, 
mass-storage device that uses removable 
CD-ROM discs. The drive contains a 
semiconductor laser for reading data optically and 
an embedded controller with a SCSI interface.

Central Processing Unit (CPU) The part of a 
workstation that interprets and executes 
instructions.

child directory See subdirectory.
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click To press and release a mouse button. The 
term comes from the fact that pressing and 
releasing most mouse buttons makes a clicking 
sound.

cluster A group of workstations connected via a 
Local Area Network (LAN). One workstation, the 
cluster server, performs as a file-system server for 
the cluster clients. See also cluster client, cluster 
node, cluster server.

cluster client A cluster node that does not have a 
local HP-UX file system. Its file system resides on 
the cluster server. See also cluster, cluster node, 
cluster server.

cluster node A member of a group of 
workstations connected via a Local Area Network 
(LAN). One workstation, the cluster server, 
performs as a server to the cluster. See also 
cluster, cluster client, cluster server.

cluster server A workstation that provides file 
access, login access, file transfer, printing, and 
other services across a network to a defined 
cluster of systems (cluster nodes) connected via a 
LAN. See also cluster, cluster client, cluster node, 
host.

command An instruction that you enter into the 
system at a prompt, to execute a program or 
perform a task. See also shell command.

command argument Information you provide on 
a command line to describe the object (usually a 
file or directory) to be operated on by the 
command.

command interpreter A program that reads lines 
of text from standard input (typed at the keyboard 
or read from a file) and interprets them as requests 
to execute other programs. An HP-UX command 
interpreter is called a shell. See also shell.

command option Information you provide on a 
command line to indicate any special action you 
want the command to take. See also default.

configuration The arrangement of a workstation 
or network as defined by the nature, number, and 
chief characteristics of its functional units. More 
specifically, the term configuration may refer to a 
hardware configuration or a software 
configuration.

control key sequence A keystroke combination 
used as a shorthand way of specifying commands. 
To enter a control key sequence, you hold down 
the control key while pressing another key.

cpu See Central Processing Unit.

CRX color graphics Expanded graphics 
capability offering 24-plane color, 24-plane 
Z-buffered color, or 48-plane Z-buffered color 
capability.

current directory See current working directory.

current session The work and processes that have 
been created since you logged into the system 
(and before you log out again). See also session.

current working directory The directory in 
which a relative path name search begins, as well 
as the directory in which you are currently 
working. It is also called the working directory or 
current directory.

cursor The small blinking box displayed in 
whatever screen is active at a particular time. The 
cursor marks your current typing position on the 
screen and indicates which program (HP VUE 
terminal window or shell) will receive your 
commands.

daisy-chaining A method of connecting devices 
where the signal passes from one device to the 
next in serial fashion along a bus.
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DDS tape drive A device that stores data on 
Digital Data Storage (DDS) cassettes.

default Most commands give you a choice of one 
or more options. If you don't specify an option, 
the command automatically assigns one. This 
automatic option is called the default. See also 
command option.

dialog box A special type of HP VUE screen that 
is called by the user from a window. Dialog boxes 
contain controls and settings. To display an 
example of a dialog box, click the Style Manager 
button on the Workspace, then click on Color.

directory A special type of object that contains 
information about the objects beneath it in the 
HP-UX organizational structure. Basically, it is a 
file that stores names and links to files and other 
directories. See also file.

disk A thin, round plate with a magnetic surface 
coating on which data is stored by magnetic 
recording. See also floppy diskette, hard disk, 
CD-ROM disc.

disked workstation A workstation that has its 
own hard disk drive. See also diskless 
workstation, node, partner node, workstation.

diskette See floppy diskette.

diskless booting Loading the operating system 
into local memory from the disk of a partner 
workstation.

diskless workstation A workstation that has no 
disk. A diskless workstation can use the disk of its 
partner workstation or other workstations. If 
necessary, it can also use the computational 
services of the partner workstation or other 
workstations. A diskless workstation boots from 
its partner workstation. See also disked 
workstation, node, partner node, workstation.

double click To press and release a mouse button 
twice in rapid succession.

drag To press and hold down a mouse button 
while moving the mouse (and the pointer on the 
screen). See also drop.

drive See CD-ROM drive, DDS tape drive, floppy 
drive, hard disk drive.

drop To release an icon that has been "dragged" 
to a new position. See also drag.

E-H

EISA (Extended Industry Standard 
Architecture) An industry standard bus 
architecture based on and compatible with that 
used by IBM in their AT series computers.

environment The conditions under which your 
commands are executed. These conditions include 
your workstation characteristics, home directory, 
and default search paths. See also environment 
variables.

environment variables The set of defined shell 
variables (some of which are PATH, TERM, 
SHELL, EXINIT, HOME) that define the 
conditions under which your commands are 
executed. These conditions include your 
workstation characteristics, home directory, and 
default search paths. See also environment.

ETHERNET The LAN developed jointly by 
Digital Equipment Corporation, Intel, and Xerox 
Corporation, upon which the IEEE 802.3 network 
is based.

fast, differential SCSI An 8-bit wide bus with 
high-power receivers and drivers, which allows a 
cable length of up to 25 meters and a speed of up 
to 10 MB per second. See also fast-wide SCSI, 
single-ended standard SCSI, Small Computer 
System Interface.
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fast-wide SCSI A 16-bit wide bus with 
high-power receivers and drivers, which allows a 
cable length of up to 25 meters and a speed of up 
to 20 MB per second. See also fast, differential 
SCSI, single-ended standard SCSI, Small 
Computer System Interface.

file The basic named unit of data stored on disk. 
See also directory, filename.

file access permissions The access rights given to 
a particular file or directory. Every file and 
directory has a set of access permissions, a code 
that determines whether a process can perform a 
requested operation on the file (such as opening 
the file or writing to it). See also access 
permissions.

File Manager The HP VUE application that 
allows you to manage your files and directories, 
and to set viewing preferences.

filename The name given to a particular file. See 
also absolute pathname, file, pathname.

file server A workstation whose primary task is to 
control the storage and retrieval of data from hard 
disks. Any number of other workstations can be 
linked to the file server in order to use it to access 
data.

file system The organized set of files and 
directories on a hard disk.

firmware The control software that is embedded 
in ROM and is always resident despite the status 
of the operating system. It handles the booting of 
the system, initialization of I/O, and starts the 
loading of the operating system.

floppy diskette A thin, record-shaped plate that 
stores data on its magnetic surfaces. The system 
uses heads (similar to heads in tape recorders) to 
read and write data on concentric disk tracks.

floppy drive A device that stores data on a 
flexible diskette.

hard disk A type of disk that is rigid as opposed 
to a floppy diskette, which is flexible.

hard disk drive A device that stores data on a 
hard disk. The hard disk is a permanent part of the 
drive and cannot be removed.

HCRX color graphics Accelerated 8-plane or 
24-plane graphics. See also CRX color graphics.

Help Manager The HP VUE application that 
provides online help.

$HOME The environment variable representing 
the home directory. This is the directory in which 
you are placed after you log in. Typically, this is 
/users/login, where login is your username. See 
also home directory.

home directory A shorthand way of referring to a 
frequently used directory, almost always the login 
directory.

host See cluster server.

host name See internet protocol address.

HP-UX cluster See cluster node, cluster server.

HP Visual User Environment A user interface 
that draws a graphical layer over the complexities 
of the other layers of the system (the hardware, 
operating system, and X Window system), 
enabling you to control your workstation by 
directly manipulating graphical objects instead of 
by typing commands at a command-line prompt.

HP VUE See HP Visual User Environment.
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icon A small, graphic representation of an object. 
Objects can be "iconized" (turned into icons) to 
clear a cluttered workspace. Icons can be restored 
to their original appearance when needed. 
Whatever processes are executing in an object 
continue to execute when the object is iconized.

iconify See iconize.

iconize To turn a window or shell into an icon. 
See also icon.

Initial System Loader The program that actually 
controls the loading of the operating system.

input device Any of several pieces of hardware 
equipment used to give information to a system. 
Examples are the keyboard and the mouse. See 
also output device.

input window The window that displays a 
program's prompt and any commands typed but 
not yet executed.

internet protocol address (IP address) A string 
of characters that uniquely identifies a 
workstation in a network. Also referred to as the 
IP address, the system name, and the host name.

invisible filename A filename in which the first 
character is a dot (.). Invisible filenames are not 
displayed by the listing commands such as ls and 
ll without add options, such as -a.

IP address See internet protocol address.

ISL See Initial System Loader.

kernel The part of the operating system that is an 
executable piece of code responsible for 
managing the computer's resources. The kernel 
controls the rest of the operating system.

LAN See local area network.

LAN station address See local area network 
station address.

link n. A special object that contains the name of 
another object. When you specify a link as a 
pathname or part of a pathname, the system 
substitutes the pathname that the link contains.

v. To join together two or more objects.

local area network (LAN) A data 
communications system that allows a number of 
independent devices to communicate with each 
other. The systems and clusters that share data, 
hardware, and software resources via Networking 
Services software.

local area network system address The label 
that uniquely identifies the local area network 
(LAN) connection for your workstation at the 
hardware level.

log in To initially sign on to the system so that 
you may begin to use it. This creates your first 
user process. See also username.

login directory The directory in which you are 
placed when you log in, usually your home 
directory. See also home directory.

Login Manager The program that controls the 
initial startup of HP VUE and accepts the user's 
username and password.

login script The shell program that runs at each 
login, and sets the login environment for your 
system.

M-Q

menu bar An area at the top or bottom of a 
window that contain the titles of the pull-down or 
pop-up menus for that application.
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minimize button In HP VUE, a push button on 
the window frame that turns a screen into an icon. 
See also icon, iconize.

mouse pointer See pointer.

name A character string associated with a file, 
directory, or link. A name can include various 
alphanumeric characters, but never a slash (/) or 
null character. See also pathname.

network Two or more workstations sharing 
information. See also cluster, workstation.

network controller A printed circuit board that 
passes bit streams between the network and the 
main memory of the workstation. Coupled with 
the network transceiver, the controller also 
handles signal processing, encoding, and network 
media access.

node A network computer (workstation). Each 
node in the network can use the data, programs, 
and devices of other network nodes. Each node 
contains main memory and has its own disk or 
shares one with another node. See also disked 
workstation, diskless workstation, workstation.

node name A unique identifying name given to a 
workstation in a cluster. See also cluster, node.

nonvolatile memory System memory that retains 
its contents even after workstation power is turned 
off.

object Any file, directory, or link in the network. 
See also directory, file, link, pathname.

operating system The program that supervises 
the execution of other programs on your 
workstation. For example, the entire HP-UX 
system, including the kernel and all HP-UX 
commands. See also kernel.

option See command option.

output device Any of several pieces of hardware 
used for receiving messages from the workstation. 
Display screens and printers are examples of 
output devices. See also input device.

output window The window that displays a 
process response to your command.

parent directory A directory that contains other 
directories, each of which is then called a 
subdirectory. See also subdirectory.

partner node A workstation that shares its disk 
with a diskless node. See also diskless 
workstation.

password The word you enter next to the 
password prompt at login time. Keep your 
password secret and change it occasionally in 
order to protect your account from unauthorized 
use. See also user account.

path The hardware address of a device that is 
attached to the I/O system of your workstation.

pathname A series of names separated by slashes 
that describe the path of the operating system 
from some starting point in the network to a 
destination object. Pathnames begin with the 
name of the starting point, and include every 
directory name between the starting point and the 
destination object. A pathname ends with the 
name of the destination object. See also name, 
object.

permissions A set of rights (read, write, execute) 
associated with an object in the file system. 
Determines who may use the object.

PID Process Identification. Also referred to as a 
process ID. See also process ID.
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pointer Sometimes called the "mouse pointer," 
the pointer shows the mouse location on the 
screen. The pointer's shape depends on its 
location. In the HP VUE Workspace, the pointer is 
an X. On a window frame, the pointer is an arrow.

process A computing environment in which you 
may execute programs; a program currently 
running in the system.

process ID A unique identification number 
assigned to all processes by the operating system. 
Also referred to as a PID. See also PID.

program A unit of executable code, in binary or 
"source" form. Most HP-UX commands and 
routines consist of programs.

prompt A message or symbol displayed by the 
system to let you know that it is ready for your 
input.

push button A graphic control that simulates a 
real-life push button. Use the pointer and mouse 
to push the button and immediately start an action.

R-Z

RAM Random access memory.

ROM Read-only memory.

root See superuser.

scroll bar A vertical or horizontal bar located on 
the side or bottom of a window that allows the 
user to view information that does not fit within 
the window.

SCSI See Small Computer System Interface.

server A program that controls all access to input 
and output devices.

session The time between when you log in and 
when you log out. Also called a work session or a 
login session. See also current session.

shell A command-line interpreter program used to 
invoke utility programs. Some examples of 
HP-UX shells are the Bourne, Korn, Key, and C 
shells. Sometimes referred to as a command 
interpreter. See also command interpreter.

shell command An instruction you give the 
system to execute a utility program or shell script. 
See also shell script, utility program.

shell script A file that contains commands that 
the system can interpret and run in a shell.

shutdown The process of taking the system from 
multi-user state to system administration state.

SIMM See Single In-line Memory Module.

single-ended standard SCSI An 8-bit wide SCSI 
bus with standard receivers and drivers, which 
limits total cable length to 6 meters. See also fast, 
differential SCSI, fast-wide SCSI, Small 
Computer System Interface.

Single In-line Memory Module A memory 
board.

slider One of the components of a scroll bar. The 
slider is the object that is dragged along the scroll 
area to cause a change.

Small Computer System Interface (SCSI) An 
IEEE standard for interfacing a computer to 
multiple, disparate high-speed peripherals such as 
a floppy disk or a CD-ROM, singly or in 
combination. See also fast, differential SCSI, 
fast-wide SCSI, single-ended standard SCSI.

standalone A workstation that is not part of a 
cluster. See also cluster.
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Style Manager The HP VUE application that 
provides the ability to customize various aspects 
of your system, including colors, fonts, the 
keyboard, the mouse, session startup and 
termination behavior, and access to other 
workstations.

subdirectory A directory that is located in, or 
anywhere on a path below, another directory. The 
directory above the subdirectory is called the 
parent directory. The subdirectory is also referred 
to as the child directory. See also parent directory.

superuser A user with permission to enter the 
top-level directory and make changes to files and 
programs that users are not allowed to change. To 
"become superuser" or "become root" means to let 
the system know that you are now assuming the 
role of system administrator. You can do this 
either by logging into the system as root, or by 
typing su at a command-line prompt. You must 
know the root password to become root.

system administrator The person responsible for 
system and network installation, updating, 
maintenance, and security at your site.

system call Invocation of a kernel process by a 
user program.

system name See internet protocol address.

workstation A compact, graphics-oriented computer 
having high speed and high memory capacity. A 
workstation usually includes a keyboard, a monitor, 
and a system unit. See also node, disked workstation, 
diskless workstation.


